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1
Product Description

The HP Pavilion dv5000 Notebook PC offers advanced 
modularity, Mobile AMD Sempron™ and AMD Turion™ 64 
Mobile Technology processors, and extensive multimedia 
support.

HP Pavilion dv5000 Notebook PC
Maintenance and Service Guide 1–1



Product Description
1.1 Features

✎ Numerous references are made throughout this Maintenance and 
Service Guide to “full-featured” and “defeatured” computer 
models. A model is considered to be full-featured if it has 3 
Universal Serial Bus ports and the following components:
■ PC Card slot
■ IEEE 1394 port
■ Digital Media Slot

A model is considered to be defeatured if it has only two 
Universal Serial Bus ports and none of the components listed 
above.

■ AMD Turion 64 ML-40 (2.2-GHz), ML-37 (2.0-GHz), 
ML-34 (1.8-GHz), ML-32 (1.8-GHz) processors, all with 
1-GB L2 cache, or Mobile AMD Sempron M3300 (2.0-GHz) 
or M3000 (1.8-GHz) processors, with 512-MB L2 cache

■ 15.4-inch, WXGA, TFT (1280 × 800) display with antiglare 
or BrightView, varying by computer model

■ 120-, 100-, 80-, 60-, or 40-GB high-capacity hard drive, 
varying by computer model

■ 256-MB DDR1 synchronous DRAM (SDRAM) at 333 MHz, 
expandable to 2.0 GB

■ Microsoft® Windows® XP Home Edition or Windows XP 
Professional, varying by computer model

■ Full-size Windows keyboard with embedded numeric keypad
1–2 Maintenance and Service Guide



Product Description
■ TouchPad pointing device, including dedicated vertical scroll 
region

■ Integrated 10Base-T/100Base-TX Ethernet local area 
network (LAN) network interface card (NIC) with RJ-45 jack

■ Integrated high-speed 56K modem with RJ-11 jack

■ Integrated wireless support for Mini PCI IEEE 802.11a/b/g 
WLAN device

■ Support for one Type I or Type II PC Card slot, with support 
for both 32-bit (CardBus) and 16-bit PC Cards

■ Support for ExpressCard slot

■ External 65-watt AC adapter with 3-wire power cord

■ 12- or 6-cell Li-Ion battery

■ Stereo speakers

■ Volume up, volume mute, and volume down buttons

■ Support for the following optical drives:

❏ DVD±RW and CD-RW Double-Layer Combo Drive with 
LightScribe

❏ DVD±RW and CD-RW Double-Layer Combo Drive

❏ DVD/CD-RW Super Multi Double-Layer Combo Drive 
with LightScribe and Hitachi LG Data Storage

❏ DVD/CD-RW Double-Layer Combo Drive with 
LightScribe

❏ DVD/CD-RW Combo Drive
Maintenance and Service Guide 1–3



Product Description
■ Connectors:

❏ Audio-in (microphone)

❏ Audio-out (headphone)

❏ Digital Media Slot (select models only)

❏ Expansion port 2

❏ ExpressCard slot

❏ External monitor

❏ IEEE 1394 (select models only)

❏ PC Card (select models only)

❏ Power

❏ RJ-11 (modem)

❏ RJ-45 (network)

❏ S-Video-out

❏ Universal Serial Bus (USB) v. 2.0 (2 or 3 ports, varying 
by computer model)

1.2 Resetting the Computer
If the computer you are servicing has an unknown password, 
follow these steps to clear the password. These steps also 
clear CMOS:

1. Prepare the computer for disassembly (refer to Section 5.3, 
“Preparing the Computer for Disassembly,” for more 
information.) Remove the real-time clock (RTC) battery 
(refer to Section 5.8, “RTC Battery,” for more information.)
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Product Description
2. Wait approximately 5 minutes.

3. Replace the RTC battery and reassemble the computer.

4. Connect AC power to the computer. Do not reinsert any 
batteries at this time.

5. Turn on the computer.

All passwords and CMOS settings have been cleared.

1.3 Power Management
The computer comes with power management features that 
extend battery operating time and conserve power. The 
computer supports the following power management features:

■ Standby

■ Hibernation

■ Setting customization by the user

■ Hotkeys for setting the level of performance

■ Battery calibration

■ Lid switch standby/resume

■ Power button

■ Advanced Configuration and Power Management (ACPM) 
compliance
Maintenance and Service Guide 1–5



Product Description
1.4 External Components
The external components on the front of the computer are shown 
below and described in Table 1-1.

Front Components
1–6 Maintenance and Service Guide



Product Description
Table 1-1

Front Components

Item Component Function

1 Power light ■ On: Computer is turned on.

■ Off: Computer is off or in hibernation.

■ Blinking: Computer is in standby.

2 Battery light ■ On: A battery is charging or is close to 
full charge capacity.

■ Off: If the computer is plugged into an 
external power source, the light is turned 
off when all batteries in the computer are 
fully charged. If the computer is not 
plugged into an external power source, 
the light stays off until the battery 
reaches a low-battery condition.

■ Blinking: A battery that is the only 
available power source has reached a 
low-battery condition. When the battery 
reaches a critical low-battery condition, 
the battery light begins blinking quickly.

3 Drive light On or blinking: The internal hard drive 
or an optical drive is being accessed.

4 Speakers Produce stereo sound.

5 Display release latch Opens the computer.
Maintenance and Service Guide 1–7



Product Description
The external components on the right side of the computer are 
shown below and described in Table 1-2.

Right-Side Components

Table 1-2

Right-Side Components

Item Component Function

1 Audio-out 
(headphone) jack

Connects an optional headphone or 
powered stereo speakers. Also connects 
the audio function of an audio/video device, 
such as a television or VCR.

2 Audio-in (microphone) 
jack

Connects an optional stereo microphone.

3 ExpressCard slot Supports an optional ExpressCard.

4 USB port (selected 
models only)

Connects optional USB devices.

5 Optical drive Supports an optical disc, such as a CD 
or DVD.

6 RJ-11 (modem) jack Connects a modem cable (not included).

7 Power connector Connects the AC adapter cable.
1–8 Maintenance and Service Guide
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The external components on the rear panel of the computer are 
shown below and described in Table 1-3.

Rear Panel Components

Table 1-3

Rear Panel Components

Item Component Function

1 Wireless light On: One or more internal wireless devices 
have been turned on.

✎ To establish a wireless connection, 
a wireless network must already be 
set up.

2 Battery bay Holds a battery.

3 Vent Provides airflow to cool internal 
components.

Ä To prevent overheating, do not 
obstruct vents. Do not allow a hard 
surface, such as a printer, or a soft 
surface, such as pillows or thick rugs 
or clothing, to block airflow.
Maintenance and Service Guide 1–9
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The external components on the left side of the computer are 
shown below and described in Table 1-4.

Left-Side Components

Table 1-4

Left-Side Components

Item Component Function

1 Security cable slot Attaches an optional security cable to the 
computer.

✎ The purpose of security solutions is 
to act as a deterrent. These solutions 
do not prevent the product from 
being mishandled or stolen.

2 Monitor port Connects an optional VGA monitor or 
projector.

3 S-Video-out jack Connects the video function of an optional 
S-Video device, such as a television, VCR, 
or video capture card.

4 RJ-45 (network) jack Connects a network cable (not included).
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5 Expansion port 2 Connects the computer to an optional 
docking device.

✎ The computer has only one 
expansion port. The term expansion 
port 2 describes the type of 
expansion port.

6 USB ports (2) Connect optional USB devices.

7 1394 port (4-pin, 
selected models only)

Connects an optional 1394a device such 
as a scanner, a digital camera, or a digital 
camcorder.

8 Digital Media Slot light 
(selected models only)

On: An optional digital card is being 
accessed.

9 Digital Media Slot 
(selected models only)

Supports the following optional digital 
cards: SD (Secure Digital) Memory Card, 
SD I/O Card, Memory Stick, Memory Stick 
Pro, MultiMediaCard, xD-Picture Card, and 
SmartMedia.

10 PC Card slot (selected 
models only)

Supports an optional Type I or Type II 32-bit 
(CardBus) or 16-bit PC Card.

11 PC Card eject button 
(selected models only)

Ejects PC Cards from the PC Card slot.

Table 1-4

Left-Side Components (Continued)

Item Component Function
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The standard keyboard components of the computer are shown 
below and described in Table 1-5.

Standard Keyboard Components
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Table 1-5

Standard Keyboard Components

Item Component Function

1 f1 to f12 keys (12) Perform system and application tasks. 
When combined with fn, function keys 
perform additional tasks as hotkeys.

2 caps lock key Enables caps lock and turns on the caps 
lock light.

3 fn key Combines with other keys to perform 
system tasks as hotkeys. For example, 
pressing fn+f7 decreases screen 
brightness.

4 Windows logo key Displays the Microsoft Windows Start 
menu.

5 Windows 
applications key

Displays a shortcut menu for items 
beneath the pointer.

6 Arrow keys Move the cursor around the screen.

7  Numeric keypad keys 
(16)

Can be used like the keys on an external 
numeric keypad.

8 num lock key Enables numeric lock, turns on the 
embedded numeric keypad, and turns 
on the num lock light.
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The computer top components are shown below and described 
in Table 1-6.

Top Components

Table 1-6

Top Components

Item Component Function

1 Caps lock light On: Caps lock is enabled.

2 Power light ■ On: The computer is on.

■ Blinking: The computer is in standby.

■ Off: The computer is off or in 
hibernation.
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2 Power button When the computer is

■ Off, press to turn on the computer.

■ On, press to enter hibernation.

■ In standby, briefly press to exit standby.

■ In hibernation, briefly press to exit 
hibernation.

If the computer has stopped responding 
and Microsoft® Windows® shutdown 
procedures cannot be used, press and 
hold the power button for at least 
5 seconds to turn off the computer.

3 QuickLaunch buttons Launch default multimedia, digital imaging, 
or music applications.

4 Wireless button Turns the wireless functionality on or off, 
but does not create a wireless connection.

✎ To establish a wireless connection, 
a wireless network must already be 
set up.

5 Wireless light On: One or more internal wireless devices 
have been turned on.

✎ To establish a wireless connection, 
a wireless network must already be 
set up.

6 Volume down button Decreases system volume.

7 Volume mute button Mutes or restores volume.

8 Volume up button Increases system volume.

9 Num lock light On: Num lock is enabled.

Table 1-6

Top Components (Continued)

Item Component Function
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The computer TouchPad components are shown below and 
described in Table 1-7.

TouchPad Components
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Table 1-7

TouchPad Components

Item Component Function

1 TouchPad Moves the pointer and selects or activates 
items on the screen. Can be set to perform 
other mouse functions, such as scrolling, 
selecting, and double-clicking.

2 Left and right TouchPad 
buttons

Function like the left and right buttons 
on an external mouse.

3 TouchPad vertical scroll 
zone

Scrolls up or down.
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The external components on the bottom of the computer are 
shown below and described in Table 1-8.

Bottom Components

Table 1-8

Bottom Components

Item Component Function

1 Optical drive Supports an optical disc, such as a 
CD or DVD.

2 Labels area Contains the serial number and other 
information labels.

3 Battery release latch Releases a battery from the battery bay.

4 Battery bay Holds a battery.
1–18 Maintenance and Service Guide



Product Description
5 Vents (2) Provide airflow to cool internal 
components.

Ä To prevent overheating, do not 
obstruct vents. Do not allow a 
hard surface, such as a printer, or 
a soft surface, such as pillows 
or thick rugs or clothing, to block 
airflow.

6 Memory/Mini PCI module 
compartment cover

■ Contains 2 memory module slots that 
support replaceable memory 
modules. The number of preinstalled 
memory modules varies by computer 
model.

■ Holds an optional wireless LAN 
device (select models only).

Ä To prevent an unresponsive 
system and the display of a 
warning message, install only a 
Mini PCI device authorized for 
use in your computer by the 
governmental agency that 
regulates wireless devices in 
your country. If you install an 
unauthorized device and then 
receive a warning message, 
remove the device to restore 
computer functionality. Then 
contact Customer Care.

7 Hard drive bay Holds the internal hard drive.

Table 1-8

Bottom Components (Continued)

Item Component Function
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1.5 Design Overview
This section presents a design overview of key parts and features 
of the computer. Refer to Chapter 3, “Illustrated Parts Catalog,” 
to identify replacement parts, and Chapter 5, “Removal and 
Replacement Procedures,” for disassembly steps.

The system board provides the following device connections:

■ Mobile AMD Sempron and AMD Turion 64 processors

■ Audio

■ Digital media card

■ Display

■ ExpressCard

■ Hard drive

■ Keyboard

■ Memory module

■ Mini PCI communications devices

■ PC Card

■ TouchPad

Ä
CAUTION: To properly ventilate the computer, allow at least a 7.6-cm 
(3-inch) clearance on the left and right sides of the computer.

The computer uses an electric fan for ventilation. The fan is 
controlled by a temperature sensor and is designed to turn on 
automatically when high temperature conditions exist. These 
conditions are affected by high external temperatures, system 
power consumption, power management/battery conservation 
configurations, battery fast charging, and software. Exhaust air is 
displaced through the ventilation grill located on the left side of 
the computer.
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2
Troubleshooting

Å
WARNING: Only authorized technicians trained by HP should repair 
this equipment. All troubleshooting and repair procedures are detailed 
to allow only subassembly-/module-level repair. Because of the 
complexity of the individual boards and subassemblies, do not attempt 
to make repairs at the component level or modifications to any printed 
wiring board. Improper repairs can create a safety hazard. Any 
indication of component replacement or printed wiring board 
modification may void any warranty or exchange allowances.

2.1 Computer Setup
Computer Setup is a system information and customization utility 
that can be used even when the operating system is not working 
or will not load. This utility includes settings that are not 
available in Windows.

Using Computer Setup

Information and settings in Computer Setup are accessed from 
the File, Security, Diagnostics, or System Configuration menus:

1. Turn on or restart the computer. Press f10 while the 
F10 = ROM-Based Setup message is displayed in 
the lower-left corner of the screen.

❏ To change the language, use the cursor control keys 
to navigate to the System Configuration menu.

❏ To view navigation information, press f1.

❏ To return to the Computer Setup menu, press esc.
Maintenance and Service Guide 2–1
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2. Select the File, Security, Diagnostics, or 
System Configuration menu.

3. To close Computer Setup and restart the computer:

❏ Select File > Save changes and exit, and then press enter.

– or –

❏ Select File > Ignore changes and exit, and then 
press enter.

– or –

❏ Select File > Restore defaults, and then press enter.

4. When you are prompted to confirm your action, press f10.

Selecting from the File Menu

Table 2-1

File Menu

Select To Do This

System Information ■ View identification information about the 
computer, processor, memory and cache size, 
and system ROM.

■ View BIOS revision, keyboard controller 
version, and battery pack serial number 
information.
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Selecting from the Security Menu

Table 2-2

Security Menu 

Select To Do This

Setup Password Enter, change, or delete an Setup password.

Power-On Password Enter, change, or delete a power-on password.

Password Options
(Password options can 
be selected only when 
a power-on password 
has been set.)

Enable/disable:

■ Stringent security.

■ Requirement of password on restart.

DriveLock Passwords Enable/disable DriveLock; change a DriveLock 
user or master password.

✎ DriveLock Settings are accessible only 
when you enter Computer Setup by turning 
on (not restarting) the computer.

Smart Card Security Enable/disable smart card power-on support.

✎ A setup password must be established to 
use this feature.

TPM Embedded Security Enable/disable:

■ Embedded security device state.

■ Power-on authentication support.

■ Automatic DriveLock support.

System IDs Establish:

■ Notebook asset tracking number.

■ Notebook ownership tags.

Disk Sanitizer Establish fast, optimum, or custom settings for 
disk sanitizing.

*Not applicable to SuperDisk LS-120 drives.
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Selecting from the Diagnostics Menu

Table 2-3

Diagnostics Menu 

Select To Do This

HDD Self-Test Options Run a quick comprehensive self test on hard 
drives in the system that support the test features.

Memory Check Run a quick comprehensive test on system 
memory on the following categories:

■ Walking 0s

■ Walking 1s

■ High Address line testing

■ Alternate Pattern testing
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Selecting from the System Configuration 
Menu

Table 2-4

System Configuration Menu 

Select To Do This

Language Change the Computer Setup language.

Boot Options Enable/disable MultiBoot, which sets a startup 
sequence that can include most bootable devices 
and media in the system.

Device Configurations Enable/disable:

■ Swap Fn/Ctrl keys.

■ USB legacy support.

■ BIOS DMA data transfers.

■ Fan Always on while on AC Power.

■ Data Execution Prevention.

■ LAN Power save.

Built-In Device Options Enable/disable:

■ Embedded WLAN Device Radio.

■ Embedded Bluetooth Device Radio.

■ LAN/WLAN Switching.

■ Wake on LAN from Off.

Port Options Enable/disable:

■ USB Port.

■ 1394 Port.

■ CardBus Slot.
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2.2 Troubleshooting Flowcharts

Table 2-5

Troubleshooting Flowcharts Overview 

Flowchart Description

2.1 “Flowchart 2.1—Initial Troubleshooting”

2.2 “Flowchart 2.2—No Power, Part 1”

2.3 “Flowchart 2.3—No Power, Part 2”

2.4 “Flowchart 2.4—No Power, Part 3”

2.5 “Flowchart 2.5—No Power, Part 4”

2.6 “Flowchart 2.6—No Video, Part 1”

2.7 “Flowchart 2.7—No Video, Part 2”

2.8 “Flowchart 2.8—Nonfunctioning Docking Device (if applicable)”

2.9 “Flowchart 2.9—No Operating System (OS) Loading”

2.10 “Flowchart 2.10—No OS Loading, Hard Drive, Part 1”

2.11 “Flowchart 2.11—No OS Loading, Hard Drive, Part 2”

2.12 “Flowchart 2.12—No OS Loading, Hard Drive, Part 3”

2.13 “Flowchart 2.13—No OS Loading, Diskette Drive”

2.14 “Flowchart 2.14—No OS Loading, Optical Drive”

2.15 “Flowchart 2.15—No Audio, Part 1”

2.16 “Flowchart 2.16—No Audio, Part 2”

2.17 “Flowchart 2.17—Nonfunctioning Device”

2.18 “Flowchart 2.18—Nonfunctioning Keyboard”

2.19 “Flowchart 2.19—Nonfunctioning Pointing Device”

2.20 “Flowchart 2.20—No Network/Modem Connection”
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Flowchart 2.1—Initial Troubleshooting
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“Flowchart 

2.15—No Audio, 
Part 1.”

Go to
“Flowchart 

2.18—Nonfunc-
tioning Keyboard” 

or “Flowchart 
2.19—Nonfunc-
tioning Pointing 

Device.”

Check
LED board,

speaker
connections.

Go to
“Flowchart 
2.20—No 

Network/Modem 
Connection.”
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Troubleshooting
Flowchart 2.2—No Power, Part 1

1. Reset the power cables in the docking device 
and at the AC outlet.

2. Be sure the AC power source is active.
3. Be sure that the power strip is working.

Done

Remove from
docking device
(if applicable).

Power up
on battery

power?

Power up
on AC

power?

Power up in 
docking 
device?

Power up
on battery

power?

Power up
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device?

Done

Reset
 power.*

Reset
 power.*

Power up
on AC power?

N

Y

Y

N

N

Y

N

N

Y

Y

Y N

1. On select computer models, there is a 
separate reset button.

2. On select computer models, the computer 
can be reset using the standby switch and 
either the lid switch or the main power 
switch.

*NOTES

Go to
“Flowchart 

2.4—No Power, 
Part 3.”

Go to
“Flowchart 

2.3—No Power, 
Part 2.”

Go to
“Flowchart 

2.8—Nonfunctioning 
Docking Device (if 

applicable).”

No power 
(power LED

is off).
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Troubleshooting
Flowchart 2.3—No Power, Part 2

Continued from
“Flowchart 

2.2—No Power, 
Part 1.”

Visually check for
debris in battery
socket and clean

if necessary.

Done

N

Y

Power on?

Check battery pack 
by

recharging it,
moving it to

another computer,

Power on?

Done

Y

Replace
power supply
(if applicable).

N

Power on?

Done

Y

N
Go to

“Flowchart 
2.4—No Power, 

Part 3.”
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Troubleshooting
Flowchart 2.4—No Power, Part 3

Continued from
“Flowchart 

2.3—No Power, 
Part 2.”

Reseat AC adapter
in computer and
at power source.

Internal or
external AC
adapter?

Done

Done

Done
Done

Power on?

Power on?

Power on?

Plug directly
into AC outlet.

Power LED
on?

Power outlet
active?

Try different
outlet.
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AC adapter.

Replace
power cord.
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N

Y

Y

Y

Y

N

N
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N
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“Flowchart 

2.5—No Power, 
Part 4.”
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Troubleshooting
Flowchart 2.5—No Power, Part 4

Y

N

Continued from
“Flowchart 

2.4—No Power, 
Part 3.”

Reseat loose
components and

boards and 
replace damaged 

items.

Open
computer.

Loose or
damaged

parts?

Y

Close
computer and

retest.

Power on?

Done

N
Replace the following items (if applicable). Check 
computer operation after each replacement:
1. Internal DC-DC converter*
2. Internal AC adapter
3. Processor board*
4. System board* 

*NOTE: Replace these items as a set to prevent 
shorting out among components.
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Troubleshooting
Flowchart 2.6—No Video, Part 1

A

N

Stand-alone
or docking 

device?

No video.

Replace the following one at a time. Test after each replacement. 
1. Cable between computer and computer display (if applicable) 
2. Display 
3. System board

Internal or
external
display*?

Adjust
brightness. Video OK? Done

Docking Device

Internal

Stand-alone

External

Adjust
brightness.

Video OK? Done

Y

Press lid
switch to ensure

operation.

Video OK? Done

Y

N

Video OK?

Done Done

N

Check for bent
pins on cable.

Try
another
display.

Internal and
external

video OK?

Replace
system
board.

Y Y

NN

*NOTE: To change from internal to 
external display, use the hotkey 
combination.

Y

Go to
“Flowchart 

2.7—No Video, 
Part 2.”
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Troubleshooting
Flowchart 2.7—No Video, Part 2

Y

N

Continued from
“Flowchart 

2.6—No Video, 
Part 1.”

Done

Adjust external
monitor display.

Video OK?

Adjust
display

brightness.

Video OK?

Video OK?

Done

Done

Check that computer is properly
seated in docking device, for 
bent pins on cable, and for

monitor connection.

Go to “A” in
“Flowchart 

2.6—No Video, 
Part 1.”

Check brightness
of external
monitor.

Try another
external
monitor.

Internal
and external
video OK?

Go to
“Flowchart 

2.8—Nonfunctioning 
Docking Device (if 

applicable).”

Y

Y

Y

N

N

N

Remove 
computer from 
docking device, 

if connected.
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Troubleshooting
Flowchart 2.8—Nonfunctioning Docking Device 
(if applicable)

Y

N

Reset power cord in 
docking device and

power outlet.

N

Test replacement 
docking device with 

new computer.

Check voltage
setting on docking 

device.

Reset monitor
cable connector at

docking device.

Reinstall
computer into 

docking device.

Docking 
device

operating?

Docking 
device

operating?

Replace docking 
device.

Done Done

Y

Nonfunctioning
docking device.
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Troubleshooting
Flowchart 2.9—No Operating System (OS) 
Loading

No OS loading from hard drive,
go to “Flowchart 2.10—No OS Loading, 

Hard Drive, Part 1.”

Reset power
cord in docking 

device and
power outlet.

No OS
loading.*

*NOTE: Before beginning troubleshooting, always 
check cable connections, cable ends, and drives 
for bent or damaged pins.

No OS loading from diskette drive,
go to “Flowchart 2.13—No OS Loading, 

Diskette Drive.”

No OS loading from CD-ROM or DVD-ROM 
drive, go to “Flowchart 2.14—No OS 

Loading, Optical Drive.”

No OS loading from network,
go to “Flowchart 2.20—No Network/Modem 

Connection.”
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Troubleshooting
Flowchart 2.10—No OS Loading, Hard Drive, 
Part 1

Go to
“Flowchart 

2.17—Nonfunctioning 
Device.”

Y

Done

N

OS not
loading from
hard drive.

Nonsystem
disk message?

Go to
“Flowchart 

2.11—No OS 
Loading, 

Hard Drive, Part 2.”

Reseat
external

hard drive.

OS loading? Done

Boot
from
CD?

Go to
“Flowchart 

2.13—No OS 
Loading, 

Diskette Drive.”

Boot
from

hard drive?

Boot
from

diskette?

Change boot
priority through
the Setup Utility

and reboot.

Boot
from

hard drive?

Y

Y

Y

Y

Y

N

N

N

N

N

Check the Setup
utility for correct

booting order.
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Troubleshooting
Flowchart 2.11—No OS Loading, Hard Drive, 
Part 2

Load OS using 
Operating System 
disc (if applicable).

Continued from
“Flowchart 

2.10—No OS 
Loading, 

Hard Drive, Part 1.”
Reseat

hard drive.

Done

CD or
diskette in

drive?

1. Replace 
hard drive.

2. Replace system 
board.

Go to
“Flowchart 

2.13—No OS 
Loading, 

Diskette Drive.”

Format hard drive
and bring to
a bootable
C:\ prompt.

Create partition, 
and then format 

hard drive to 
bootable

C:\ prompt.

Boot
from diskette

drive?

Remove
diskette and

reboot.

Y

N

Boot
from

hard drive?

Y

N

Y

N

Hard drive 
accessible?

Y

N

Hard drive
accessible?

Done

Run FDISK.

Y

N

Hard drive
partitioned?

Hard drive
formatted?

Y

N

Y

N

Computer
booted?

Done

Y

N
Go to

“Flowchart 
2.12—No OS 

Loading, 
Hard Drive, Part 3.”

Go to
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2.12—No OS 
Loading, 
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Troubleshooting
Flowchart 2.12—No OS Loading, Hard Drive, 
Part 3

Y

System
files on hard

drive?

Continued from
“Flowchart 

2.11—No OS 
Loading, 

Hard Drive, Part 2.”

Clean virus. Done

N

Install OS
and reboot.

Virus
on 
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OS
loading from
hard drive?
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N

Y

N

Y

N

Diagnostics
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Replace
hard drive.
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Replace
hard drive.

Y

N

Y

N

Fix bad
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Boot from
hard drive?

Replace
hard drive.

Done
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Troubleshooting
Flowchart 2.13—No OS Loading, Diskette Drive

Done

Y

N

Reseat
diskette drive.

OS not loading
from

diskette drive.

Done

Y

Y

YY

Y Y

YN

N

N

N

N

N

N

OS
loading?

Nonsystem
disk message?

Bootable
diskette
in drive?

Install bootable
diskette and

reboot computer.

Check diskette
for system files.

Try different
diskette.

1. Replace diskette 
drive.

2. Replace system 
board.

Nonsystem
disk error?

OS
loading?

Boot
from another

device?

Enable drive
and cold boot

computer.

Is diskette
drive boot

order 
correct?

Change boot
priority using

the Setup Utility.

Go to
“Flowchart 

2.17—Nonfunc-
tioning Device.”

Diskette
drive enabled
in the Setup

Utility?

Go to
“Flowchart 

2.17—Nonfunctioning 
Device.”

Reset the computer. 
Refer to

Section 1.2, 
“Resetting the 
Computer,” for 

instructions.
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Troubleshooting
Flowchart 2.14—No OS Loading, Optical Drive

Y

Done

N

Bootable
disc in
drive?

Disc
in drive?

No OS
loading from
CD-ROM or

DVD-ROM drive.

Install bootable
disc and
reboot
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2.17—Nonfunctioning 
Device.”
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2.17—Nonfunctioning 
Device.”

Install
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drive.
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Y
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N

N

N
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Computer,” for
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Troubleshooting
Flowchart 2.15—No Audio, Part 1

No audio.

N

Computer in
docking device
(if applicable)?

Internal
audio?

Audio? Done

Undock

Audio? Done

Turn up audio
internally or
externally.

Go to
“Flowchart 
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“Flowchart 
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Device.”
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Troubleshooting
Flowchart 2.16—No Audio, Part 2

Y N

Continued from 
“Flowchart 

2.15—No Audio, 
Part 1.”

Reload
audio drivers.

Audio
driver in OS
configured?

Audio?

Y

Y

YN

N

N

Correct
drivers for

application?

Connect to
external
speaker.

Load drivers and
set configuration

in OS.

Audio? Done

Replace audio
board and
speaker

connections
in computer 

(if applicable).

1. Replace internal speakers.
2. Replace audio board (if applicable).
3. Replace system board.
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Troubleshooting
Flowchart 2.17—Nonfunctioning Device

Done

Any physical
device detected?

Y

N

Unplug the nonfunctioning device from the computer 
and inspect cables and plugs for bent or broken pins or 

other damage.

Reseat 
device.

Clear
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Done
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broken item.
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device.
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Close computer,
plug in power,

and reboot.
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boots
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Troubleshooting
Flowchart 2.18—Nonfunctioning Keyboard
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Troubleshooting
Flowchart 2.19—Nonfunctioning Pointing 
Device
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N
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Troubleshooting
Flowchart 2.20—No Network/Modem 
Connection
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Done
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3
Illustrated Parts Catalog

This chapter provides an illustrated parts breakdown and a 
reference for spare part numbers.

3.1 Serial Number Location
When ordering parts or requesting information, provide the 
computer serial number and model number located on the bottom 
of the computer.

Serial Number Location
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Illustrated Parts Catalog
3.2 Computer Major Components

Computer Major Components
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Illustrated Parts Catalog
Table 3-1

Spare Parts: Computer Major Components

Item Description
Spare Part 
Number

1 Display assemblies (include display cable, wireless antenna boards, 
and antenna cables)

15.4-inch, WXGA with BrightView
15.4-inch, WXGA antiglare

407841-001
407839-001

✎ Refer to Section 3.3, “Display Assembly Subcomponents,” for 
display assembly internal component spare part number 
information.

2 Switch cover

For use with full-featured models
For use with defeatured models

407825-001
407826-001

3 Keyboard frame 407786-001

4 LED board (includes LED board cable) 417023-001

5 Keyboards

Belgium
Denmark
France
French Canada
Germany
Greece
International
Israel
Italy
Latin America

407857-A41
407857-081
407857-051
407857-121
407857-041
407857-151
407857-B31
407857-BB1
407857-061
407857-161

Norway
Portugal
Saudi Arabia
Spain
Sweden/Finland
Switzerland
Turkey
The United 

Kingdom
The United 

States

407857-091
407857-131
407857-171
407857-071
407587-B71
407857-111
407857-141
407857-031

407857-001

6 Top cover (includes TouchPad)
TouchPad bracket (not illustrated)

407822-001
407811-001
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Illustrated Parts Catalog
Table 3-1

Spare Parts: Computer Major Components (Continued)

Item Description
Spare Part 
Number

Cable Kit 407774-001

7a
7b
7c
7d

7e

Includes:
TouchPad cable
USB/audio board cable
Bluetooth module cable
Power connector and cable

✎ The power connector cable is also available using spare part 
number 415495-001.

Modem connector and cable

8 Optical drives

DVD±RW and CD-RW Double-Layer Combo Drive 
with LightScribe
DVD/CD-RW Double-Layer Combo Drive with 
LightScribe
DVD/CD-RW Combo Drive

403806-001

407855-001

407854-001

DVD/CD-RW Super Multi Double-Layer Combo Drive 
with LightScribe and Hitachi LG Data Storage
DVD±RW and CD-RW Double-Layer Combo Drive
DVD±RW and CD-RW Double-Layer Combo Drive 
with LightScribe

417698-001

430856-001
430857-001

9 PC Card assembly 407829-001

10 ExpressCard assembly 407809-001
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Illustrated Parts Catalog
Table 3-1

Spare Parts: Computer Major Components (Continued)

Item Description
Spare Part 
Number

11 Plastics Kit 407778-001

11a
11b
11c

11d

Includes:
ExpressCard slot bezel
PC Card slot bezel
Hard drive cover (includes 2 captive screws secured by C-clips)

✎ The hard drive cover is also available using spare part number 
419328-001.

Memory/Mini PCI module compartment cover (includes 2 captive 
screws secured by C-clips)
Computer feet (8, not illustrated)

Bracket Kit 407820-001

12a
12b
12c
12d

Includes:
ExpressCard bracket
Expansion port 2 bracket
Display hinge support bracket
Memory shield

13 USB/audio board (includes USB/audio board cable)

For use with full-featured models
For use with defeatured models

417025-001
417026-001

14 System board

For use with full-featured models
For use with defeatured models

417021-001
417022-001

15 Bluetooth® module (includes Bluetooth module cable) 397922-001

16 Heat sink (includes thermal paste)
Thermal paste

403827-001
407817-001

17 Fan assembly 407807-001
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Illustrated Parts Catalog
Table 3-1

Spare Parts: Computer Major Components (Continued)

Item Description
Spare Part 
Number

18 Processors (include thermal paste)

AMD Turion 64 ML-40 (2.2-GHz)
AMD Turion 64 ML-40 (2.2-GHz)
AMD Turion 64 ML-37 (2.0-GHz)
AMD Turion 64 ML-34 (1.8-GHz)
AMD Turion 64 ML-32 (1.8-GHz)

430499-001
393579-001
393578-001
407836-001
395744-001

Mobile AMD Sempron M3300 (2.0-GHz)
Mobile AMD Sempron M3100 (1.8-GHz)
Mobile AMD Sempron M3000 (1.8-GHz)

407837-001
430855-001
407838-001

19 Speakers 407784-001

20 Base enclosure

For use with full-featured models
For use with defeatured models

407813-001
407814-001

21 RTC battery (includes 2-sided tape) 407816-001

22 Batteries

12-cell, 8.8-Amp hour
6-cell, 4.0-Amp hour

407835-001
407834-001
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Illustrated Parts Catalog
Table 3-1

Spare Parts: Computer Major Components (Continued)

Item Description
Spare Part 
Number

23 Hard drives (include frame)

5400-rpm, 80-GB 418584-001 4200-rpm, 120-GB
4200-rpm, 100-GB
4200-rpm, 80-GB
4200-rpm, 60-GB
4200-rpm, 40-GB

418856-001
418583-001
418585-001
418582-001
418581-001

Hard drive cover (identified by number 11c) 419328-001

24 Mini PCI communications modules

802.11a/b/g WLAN module for use in North America
802.11a/b/g WLAN module for use in the rest of the 
world

403791-001
403792-001

802.11b/g WLAN module for use in North America
802.11b/g WLAN module for use in the rest of the world

392557-001
392557-002

25 Memory modules, 1-DIMM SD Memory Cards 
(not illustrated)

1024 MB
512 MB
256 MB

403800-001
403799-001
407843-001

512 MB
256 MB

407316-001
403573-001
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3.3 Display Assembly Subcomponents
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Illustrated Parts Catalog
Table 3-2

Display Assembly Subcomponents

Spare Part Number Information

Item Description

1a
1b

Display Plastics Kit, includes:

■ Display bezel

■ Display enclosure

■ Display release latch actuator and hooks 
(not illustrated)

407792-001

2 Display Hinge Kit 407796-001

3 Display inverter board 407800-001

4 Display Panel Kit (includes display panel cable)
15.4-inch, WXGA with BrightView
15.4-inch, WXGA antiglare

407799-001
407798-001

5 Wireless Antenna Kit (includes cable and 
transceivers)

407791-001

Display Label Kit (not illustrated) 407864-001

Display Screw Kit (not illustrated), includes:

■ Phillips PM2.5×7.0 screws

■ Phillips PM2.0×4.0 screws

■ Rubber screw covers

407794-001
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3.4 Plastics Kit

Table 3-3

Plastics Kit

Spare Part Number Information

Item Description
Spare Part 
Number

Plastics Kit
Includes:

407778-001

1 Memory/Mini PCI module compartment cover (includes 2 captive 
screws, secured by C-clips)

2 Hard drive cover (includes 2 captive screws, secured by C-clips)

✎ The hard drive cover is also available using spare part number 
419328-001.

3 Computer feet for use on base enclosure (6)

4 Computer feet for use on 12-cell battery

5 ExpressCard slot bezel

6 PC Card slot bezel
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Illustrated Parts Catalog
3.5 Cable Kit

Table 3-4

Cable Kit

Spare Part Number Information

Item Description
Spare Part 
Number

Cable Kit
Includes:

407774-001

1 TouchPad cable

2 Bluetooth module cable

3 USB/audio board cable

4 Modem connector and cable

5 Power connector and cable

✎ The power connector cable is also available using spare part 
number 415495-001.
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3.6 Mass Storage Devices
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Illustrated Parts Catalog
Table 3-5

Mass Storage Devices

Spare Part Number Information

Item Description
Spare Part 
Number

1 Hard drives (include frame)

5400-rpm, 80-GB 418584-001 4200-rpm, 120-GB
4200-rpm, 100-GB
4200-rpm, 80-GB
4200-rpm, 60-GB
4200-rpm, 40-GB

418856-001
418583-001
418585-001
418582-001
418581-001

2 Optical drives

DVD±RW and CD-RW Double-Layer Combo Drive with 
LightScribe
DVD/CD-RW Double-Layer Combo Drive with 
LightScribe
DVD/CD-RW Combo Drive

403806-001

407855-001

407854-001

DVD/CD-RW Super Multi Double-Layer Combo Drive 
with LightScribe and Hitachi LG Data Storage
DVD±RW and CD-RW Double-Layer Combo Drive
DVD±RW and CD-RW Double-Layer Combo Drive with 
LightScribe

417698-001

430856-001
430857-001

USB digital drive (not illustrated) 364727-001
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3.7 Miscellaneous (Not Illustrated)

Table 3-6

Miscellaneous (Not Illustrated)

Spare Part Information

Description
Spare Part 
Number

All-in-one media cable 375759-001

Analog TV tuner 407941-001

Audio Y-cable 2 379452-001

Composite S-Video and audio cable 407939-001

DVB-T TV tuner 412175-001

DVB-T TV tuner antenna 412176-001

HP Remote Control II 407313-001

Label Kit 407776-001

Power supply, 65 watt 403810-001

RF cable 408485-001

RF input adapter cable 407940-001

TV tuner remote control 408479-001

USB infrared receiver 408483-001
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Power cords

For use in:

Australia 403811-011

Canada, French Canada, and the United States 403811-001

Denmark 403811-081

France, Germany, and Spain 403811-021

Israel 403811-BB1

The United Kingdom 403811-031

Switzerland 403811-111

Italy 403811-061

Screw Kit (includes the following screws; refer to
Appendix A, “Screw Listing,” for more information 
on specifications and usage)

407782-001

■ Phillips PM3.0×6.0 Screw

■ Phillips PM3.0×3.0 screw

■ Phillips PM2.5×11.0 screw

■ Phillips PM2.5×7.0 Screw

■ Phillips PM2.5×6.0 screw

■ Black Phillips PM2.5×5.0 screw

■ Silver Phillips PM2.5×5.0 Screw

■ Phillips PM2.5×3.0 screw

■ Phillips PM2.0×6.0 Screw

■ Phillips PM2.0×4.0 Screw

■ Phillips PM2.0×3.0 Screw

■ Slotted SM1.5×9.0 screw

USB travel mouse 309674-001

USB digital drive 364727-001

Wired headset with volume control 371693-001

Table 3-6

Miscellaneous (Not Illustrated)

Spare Part Information (Continued)

Description
Spare Part 
Number
Maintenance and Service Guide 3–19



Illustrated Parts Catalog
3.8 Sequential Part Number Listing

Table 3-7

Sequential Part Number Listing

Spare Part 
Number Description

309674-001 USB travel mouse

364727-001 USB digital drive

371693-001 Wired headset with volume control

392557-001 802.11b/g WLAN Mini PCI communications module for use in 
North America

392557-002 802.11b/g WLAN Mini PCI communications module for use in 
the rest of the world

393578-001 AMD Turion 64 ML-37 (2.0-GHz) processor (includes 
thermal paste)

393579-001 AMD Turion 64 ML-40 (2.2-GHz) processor (includes 
thermal paste)

395744-001 AMD Turion 64 ML-32 (1.8-GHz) processor (includes 
thermal paste)

397922-001 Bluetooth wireless module (includes Bluetooth module cable)

403573-001 SD Memory Card 256-MB

403791-001 802.11a/b/g WLAN Mini PCI communications module for use in 
North America

403792-001 802.11a/b/g WLAN Mini PCI communications module for use in 
the rest of the world

403799-001 512-MB memory module
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403800-001 1024-MB memory module

403806-001 DVD±RW and CD-RW Double-Layer Combo Drive 
with LightScribe

403810-001 Power supply, 65 watt

403811-001 Power cord for use in the United States

403811-011 Power cord for use in Australia

403811-021 Power cord for use internationally

403811-031 Power cord for use in the United Kingdom

403811-061 Power cord for use in Italy

403811-081 Power cord for use in Denmark

403811-111 Power cord for use in Sweden and Finland

403811-BB1 Power cord for use in Israel

403827-001 Heat sink (includes thermal paste)

407313-001 HP Remote Control II

407316-001 SD Memory Card 512-MB

407774-001 Cable Kit

407776-001 Label Kit

407778-001 Plastics Kit

407780-001 Rubber Pad Kit

Table 3-7

Sequential Part Number Listing (Continued)

Spare Part 
Number Description
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407782-001 Screw Kit

407784-001 Speakers

407786-001 Keyboard frame

407791-001 Wireless antenna transceivers and cables

407792-001 Display Plastics Kit

407794-001 Display Screw Kit

407796-001 Display HInge Kit

407798-001 Display panel kit for use with antiglare displays

407799-001 Display panel kit for use with BrightView displays

407800-001 Display inverter board

407807-001 Fan assembly

407809-001 ExpressCard assembly

407811-001 TouchPad bracket

407813-001 Base enclosure for use with full-featured computers

407814-001 Base enclosure for use with defeatured computers

407816-001 RTC battery (includes 2-sided tape)

407817-001 Thermal paste

407820-001 Bracket Kit

407822-001 Top cover

Table 3-7

Sequential Part Number Listing (Continued)

Spare Part 
Number Description
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407825-001 Switch cover for use with full-featured computers

407826-001 Switch cover for use with defeatured computers

407829-001 PC Card assembly

407834-001 6-cell, 4.0-Amp hour battery

407835-001 12-cell, 8.8-Amp hour battery

407836-001 AMD Turion 64 ML-34 (1.8-GHz) processor (includes 
thermal paste)

407837-001 Mobile AMD Sempron M3000 (1.8-GHz) processor (includes 
thermal paste)

407838-001 Mobile AMD Sempron M3300 (2.0-GHz) processor (includes 
thermal paste)

407839-001 15.4-inch WSGA antiglare display assembly

407841-001 15.4-inch WSGA display assembly with BrightView

407843-001 256-MB, 1-DIMM memory module

407854-001 DVD/CD-RW Combo Drive

407855-001 DVD/CD-RW Double-Layer Combo Drive with LightScribe

407857-001 Keyboard for use in The United States

407857-031 Keyboard for use in The United Kingdom

407857-041 Keyboard for use in Germany

407857-051 Keyboard for use in France

Table 3-7

Sequential Part Number Listing (Continued)

Spare Part 
Number Description
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407857-061 Keyboard for use in Italy

407857-071 Keyboard for use in Spain

407857-081 Keyboard for use in Denmark

407857-091 Keyboard for use in Norway

407857-111 Keyboard for use in Switzerland

407857-121 Keyboard for use in French Canada

407857-131 Keyboard for use in Portugal

407857-141 Keyboard for use in Turkey

407857-151 Keyboard for use in Greece

407857-161 Keyboard for use in Latin America

407857-171 Keyboard for use in Saudi Arabia

407857-A41 Keyboard for use in Belgium

407857-B31 Keyboard for use internationally

407857-B71 Keyboard for use in Sweden and Finland

407857-BB1 Keyboard for use in Israel

407864-001 Display Label Kit

407939-001 Composite S-Video and audio cable

407940-001 RF input adapter cable

407941-001 Analog TV tuner

Table 3-7

Sequential Part Number Listing (Continued)

Spare Part 
Number Description
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408479-001 TV tuner remote control

408483-001 USB infrared receiver

408485-001 RF cable

412175-001 DVB-T TV tuner

412176-001 DVB-T TV tuner antenna

415495-001 Power connector cable

417021-001 System board for use with full-featured computer models

417022-001 System board for use with defeatured computer models

417023-001 LED board for use with full-featured computer models

417025-001 USB/audio board for use with full-featured computer models

417026-001 USB/audio board for use with defeatured computer models

417698-001 DVD/CD-RW Super Multi Double-Layer Combo Drive with 
LightScribe and Hitachi LG Data Storage

418581-001 4200-rpm, 40-GB hard drive

418582-001 4200-rpm, 60-GB hard drive

418583-001 4200-rpm, 100-GB hard drive

418584-001 5400-rpm, 80-GB hard drive

418585-001 4200-rpm, 80-GB hard drive

418586-001 4200-rpm, 120-GB hard drive

419328-001 Hard drive cover

Table 3-7

Sequential Part Number Listing (Continued)

Spare Part 
Number Description
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430499-001 AMD Turion 64 ML-40 (2.2-GHz) processor (includes 
thermal paste)

430855-001 Mobile AMD Sempron-M 3100 (1.8-GHz) processor (includes 
thermal paste)

430856-001 DVD±RW and CD-RW Double-Layer Combo Drive

430857-001 DVD±RW and CD-RW Double-Layer Combo Drive with 
LightScribe

Table 3-7

Sequential Part Number Listing (Continued)

Spare Part 
Number Description
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4
Removal and Replacement

Preliminaries

This chapter provides essential information for proper and 
safe removal and replacement service.

4.1 Tools Required
You will need the following tools to complete the removal and 
replacement procedures:
■ Magnetic screwdriver
■ Phillips P0 and P1 screwdrivers
■ Flat-bladed screwdriver
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4.2 Service Considerations
The following sections include some of the considerations 
that you should keep in mind during disassembly and assembly 
procedures.

✎ As you remove each subassembly from the computer, place 
the subassembly (and all accompanying screws) away from 
the work area to prevent damage.

Plastic Parts

Using excessive force during disassembly and reassembly can 
damage plastic parts. Use care when handling the plastic parts. 
Apply pressure only at the points designated in the maintenance 
instructions.

Cables and Connectors

Ä
CAUTION: When servicing the computer, ensure that cables are 
placed in their proper locations during the reassembly process. 
Improper cable placement can damage the computer.

Cables must be handled with extreme care to avoid damage. 
Apply only the tension required to unseat or seat the cables 
during removal and insertion. Handle cables by the connector 
whenever possible. In all cases, avoid bending, twisting, or 
tearing cables. Ensure that cables are routed in such a way that 
they cannot be caught or snagged by parts being removed or 
replaced. Handle flex cables with extreme care; these cables 
tear easily.
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4.3 Preventing Damage to 
Removable Drives
Removable drives are fragile components that must be handled 
with care. To prevent damage to the computer, damage to a 
removable drive, or loss of information, observe the following 
precautions:
■ Before removing or inserting a hard drive, shut down the 

computer. If you are unsure whether the computer is off or 
in Hibernation, turn the computer on, and then shut it down 
through the operating system.

■ Before removing a diskette drive or optical drive, ensure that 
a diskette or disc is not in the drive and ensure that the optical 
drive tray is closed.

■ Before handling a drive, ensure that you are discharged of 
static electricity. While handling a drive, avoid touching the 
connector.

■ Handle drives on surfaces covered with at least one inch of 
shock-proof foam.

■ Avoid dropping drives from any height onto any surface.
■ After removing a hard drive, CD-ROM drive, or a diskette 

drive, place it in a static-proof bag.
■ Avoid exposing a hard drive to products that have magnetic 

fields, such as monitors or speakers.
■ Avoid exposing a drive to temperature extremes or liquids.
■ If a drive must be mailed, place the drive in a bubble pack 

mailer or other suitable form of protective packaging and label 
the package, “FRAGILE: Handle With Care.”
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4.4 Preventing Electrostatic Damage
Many electronic components are sensitive to electrostatic 
discharge (ESD). Circuitry design and structure determine the 
degree of sensitivity. Networks built into many integrated circuits 
provide some protection, but in many cases, the discharge 
contains enough power to alter device parameters or melt 
silicon junctions.

A sudden discharge of static electricity from a finger or other 
conductor can destroy static-sensitive devices or microcircuitry. 
Often the spark is neither felt nor heard, but damage occurs.

An electronic device exposed to electrostatic discharge might not 
be affected at all and can work perfectly throughout a normal 
cycle. Or the device might function normally for a while, then 
degrade in the internal layers, reducing its life expectancy.
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4.5 Packaging and Transporting 
Precautions
Use the following grounding precautions when packaging and 
transporting equipment:
■ To avoid hand contact, transport products in static-safe 

containers, such as tubes, bags, or boxes.
■ Protect all electrostatic-sensitive parts and assemblies with 

conductive or approved containers or packaging.
■ Keep electrostatic-sensitive parts in their containers until 

the parts arrive at static-free workstations.
■ Place items on a grounded surface before removing items 

from their containers.
■ Always be properly grounded when touching a sensitive 

component or assembly.
■ Store reusable electrostatic-sensitive parts from assemblies 

in protective packaging or nonconductive foam.
■ Use transporters and conveyors made of antistatic belts and 

roller bushings. Ensure that mechanized equipment used for 
moving materials is wired to ground and that proper materials 
are selected to avoid static charging. When grounding is not 
possible, use an ionizer to dissipate electric charges.
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4.6 Workstation Precautions
Use the following grounding precautions at workstations:
■ Cover the workstation with approved static-shielding material 

(refer to Table 4-2, “Static-Shielding Materials”).
■ Use a wrist strap connected to a properly grounded work 

surface and use properly grounded tools and equipment.
■ Use conductive field service tools, such as cutters, 

screwdrivers, and vacuums.
■ When using fixtures that must directly contact dissipative 

surfaces, only use fixtures made of static-safe materials.
■ Keep the work area free of nonconductive materials, such 

as ordinary plastic assembly aids and Styrofoam.
■ Handle electrostatic-sensitive components, parts, and 

assemblies by the case or PCM laminate. Handle these 
items only at static-free workstations.

■ Avoid contact with pins, leads, or circuitry.
■ Turn off power and input signals before inserting or removing 

connectors or test equipment.
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4.7 Grounding Equipment and 
Methods
Grounding equipment must include either a wrist strap or a 
foot strap at a grounded workstation.
■ When seated, wear a wrist strap connected to a grounded 

system. Wrist straps are flexible straps with a minimum of 
one megohm ±10% resistance in the ground cords. To provide 
proper ground, wear a strap snugly against the skin at all times. 
On grounded mats with banana-plug connectors, use alligator 
clips to connect a wrist strap.

■ When standing, use foot straps and a grounded floor mat. 
Foot straps (heel, toe, or boot straps) can be used at standing 
workstations and are compatible with most types of shoes 
or boots. On conductive floors or dissipative floor mats, use 
foot straps on both feet with a minimum of one megohm 
resistance between the operator and ground. To be effective, 
the conductive strips must be worn in contact with the skin.

Other grounding equipment recommended for use in preventing 
electrostatic damage includes:
■ Antistatic tape
■ Antistatic smocks, aprons, and sleeve protectors
■ Conductive bins and other assembly or soldering aids
■ Nonconductive foam
■ Conductive tabletop workstations with ground cords of 

one megohm resistance
■ Static-dissipative tables or floor mats with hard ties to 

the ground
■ Field service kits
■ Static awareness labels
■ Material-handling packages
■ Nonconductive plastic bags, tubes, or boxes
■ Metal tote boxes
■ Electrostatic voltage levels and protective materials
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Table 4-1 shows how humidity affects the electrostatic voltage 
levels generated by different activities.

Table 4-2 lists the shielding protection provided by antistatic 
bags and floor mats.

Table 4-1

Typical Electrostatic Voltage Levels

Relative Humidity

Event 10% 40% 55%

Walking across carpet 35,000 V 15,000 V 7,500 V

Walking across vinyl floor 12,000 V  5,000 V 3,000 V

Motions of bench worker 6,000 V 800 V 400 V

Removing DIPS from plastic tube 2,000 V 700 V 400 V

Removing DIPS from vinyl tray 11,500 V 4,000 V 2,000 V

Removing DIPS from Styrofoam 14,500 V 5,000 V 3,500 V

Removing bubble pack from PCB 26,500 V 20,000 V 7,000 V

Packing PCBs in foam-lined box 21,000 V 11,000 V 5,000 V

✎ A product can be degraded by as little as 700 V.

Table 4-2

Static-Shielding Materials

Material Use Voltage Protection Level

Antistatic plastic Bags 1,500 V

Carbon-loaded plastic Floor mats 7,500 V

Metallized laminate Floor mats 5,000 V
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Removal and Replacement

Procedures

This chapter provides removal and replacement procedures.

There are as many 100 screws, in 12 different sizes, that may 
have to be removed, replaced, or loosened when servicing the 
computer. Make special note of each screw size and location 
during removal and replacement.

Refer to Appendix A, “Screw Listing,” for detailed information 
on screw sizes, locations, and usage.

5.1 Serial Number
Report the computer serial number to HP when requesting 
information or ordering spare parts. The serial number is 
located on the bottom of the computer.

Serial Number Location
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5.2 Disassembly Sequence Chart
Use the chart below to determine the section number to be 
referenced when removing computer components.

Disassembly Sequence Chart

Section Description # of Screws Removed

5.3 Preparing the Computer for 
Disassembly

Battery 0

5.4 Hard Drive 2 loosened to remove the 
hard drive cover
2 to remove the hard drive
4 to disassemble the 
hard drive

5.5 Computer Feet 0

5.6 Memory Module 2 loosened to remove the 
memory/Mini PCI module 
compartment cover
2 loosened to release the 
memory shield

5.7 Mini PCI Communications 
Module

0

Å To prevent an unresponsive system and the display of a 
warning message, install only a Mini PCI device authorized 
for use in your computer by the governmental agency that 
regulates wireless devices in your country. If you install a 
device and then receive a warning message, remove the 
device to restore computer functionality. Then contact 
Customer Care.

5.8 RTC Battery 0
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Section Description # of Screws Removed

5.9 Optical Drive 1 to remove to optical drive
2 to remove the optical drive 
bracket

5.10 Switch Cover 7

5.11 Keyboard Frame 1

5.12 LED Board 5

5.13 Keyboard 4

5.14 Display Assembly 4 to remove the display 
assembly
8 to remove the display bezel
2 to remove the display panel
4 to remove each display 
hinge
1 to remove each wireless 
antenna transceiver

5.15 Top Cover 21

5.16 Bluetooth Module 1

5.17 System Board 6

5.18 USB/Audio Board 1

5.19 Heat Sink 4

5.20 Processor 1 loosened on select models

5.21 Fan Assembly 5

5.22 Speakers 1

5.23 PC Card Assembly 2

5.24 ExpressCard Assembly 2

Disassembly Sequence Chart (Continued)
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5.3 Preparing the Computer for 
Disassembly
Before you begin any removal or installation procedures: 

1. Shut down the computer. If you are unsure whether the 
computer is off or in hibernation, turn the computer on, 
and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power cord.

4. Remove the battery by following these steps:

a. Turn the computer upside down with the front toward you.

Battery Spare Part Number Information

12-cell, 8.8-Amp hour
6-cell, 4.0-Amp hour

407835-001
407834-001
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b. Slide the battery release latch 1 to the left. (The battery 
disengages from the computer.)

c. Lift the front edge of the battery 2 and swing it back to 
remove it.

Removing the Battery

Reverse the above procedure to install the battery.
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5.4 Hard Drive

1. Prepare the computer for disassembly (refer to Section 5.3).

Hard Drive Spare Part Number Information

5400-rpm, 80-GB 418584-001

4200-rpm, 120-GB
4200-rpm, 100-GB
4200-rpm, 80-GB
4200-rpm, 60-GB
4200-rpm, 40-GB

418856-001
418583-001
418585-001
418582-001
418581-001
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2. Loosen the two black Phillips PM2.5×5.0 screws 1 that 
secure the hard drive cover to the computer.

3. Lift the left edge of the hard drive cover 2 and swing it up 
and to the right and remove it.

✎ The hard drive cover is included in the Plastics Kit, spare part 
number 407778-001. The hard drive cover is also available 
using spare part number 419328-001.

Removing the Hard Drive Cover
Maintenance and Service Guide 5–7



Removal and Replacement Procedures
4. Remove the two Phillips PM2.5×6.0 hard drive retention 
screws 1 that secure the hard drive to the computer.

5. Slide the hard drive 2 to the right to disconnect if from 
the system board.

6. Remove the hard drive 3 from the hard drive bay.

Removing the Hard Drive
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7. Remove the four Phillips PM3.0×3.0 hard drive frame 
screws 1 that secure the hard drive frame to the hard drive.

8. Lift the hard drive straight up 2 to remove it from the hard 
drive frame.

Removing the Hard Drive Frame

Reverse the above procedure to reassemble and install the 
hard drive.
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5.5 Computer Feet
The computer feet are adhesive-backed rubber pads. The feet are 
included in the Plastics Kit, spare part number 407778-001.

Replacing the Computer Feet
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5.6 Memory Module

1. Prepare the computer for disassembly (refer to Section 5.3).

2. Loosen the two black Phillips PM2.5×5.0 screws 1 that 
secure the memory/Mini PCI module compartment cover to 
the computer.

3. Lift the right side of the cover 2 and swing it up and to the 
left and remove it.

✎ The memory/Mini PCI module compartment cover is included 
in the Plastics Kit, spare part number 407778-001.

Removing the Memory/Mini PCI Module Compartment Cover

Memory Module Spare Part Number Information

1024 MB
512 MB
256 MB

403800-001
403799-001
407843-001
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4. Loosen the two Phillips PM2.5×3.0 screws 1 that secure 
the memory module shield to the computer.

5. Lift the left side of the shield 2 and swing it to the right 
until it is resting in an upright position.

✎ The memory shield is included in the Bracket Kit, spare part 
number 407820-001.

Releasing the Memory Module Shield
5–12 Maintenance and Service Guide



Removal and Replacement Procedures
6. Spread the retaining tabs 1 on each side of the memory 
module socket to release the memory module. (The edge 
of the module opposite the socket rises away from 
the computer.)

7. Remove the memory module by pulling the module away 
from the socket at an angle 2.

✎ Memory modules are designed with notches 3 to prevent 
incorrect installation into the memory module socket.

Removing the Memory Module

Reverse the above procedure to install a memory module.
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5.7 Mini PCI Communications Module

1. Prepare the computer for disassembly (Section 5.3).

2. Remove the memory/Mini PCI module compartment cover 
(Section 5.6).

Mini PCI Communications Module

Spare Part Number Information

802.11a/b/g WLAN module for use in North America
802.11a/b/g WLAN module for use in the rest of the world

403791-001
403792-001

802.11b/g WLAN module for use in North America
802.11b/g WLAN module for use in the rest of the world

392557-001
392557-002
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✎ Before disconnecting the antenna cables, make note of which 
cable is attached to which antenna clip on the Mini PCI 
communications card.

3. Disconnect the auxiliary and main 1 antenna cables from 
the Mini PCI communications module.

4. Spread the two retaining tabs 2 on each side of the 
Mini PCI socket to release the Mini PCI communications 
module. (The edge of the module opposite the socket rises 
away from the computer.)

5. Remove the Mini PCI communications module by pulling 
the module away from the socket at an angle 3.

✎ Mini PCI communications modules are designed with 
notches 4 to prevent incorrect installation into the Mini PCI 
module socket.

Removing a Mini PCI Communications Module

Reverse the above procedure to install a Mini PCI 
communications module.
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5.8 RTC Battery

1. Prepare the computer for disassembly (Section 5.3).

2. Remove the memory/Mini PCI module compartment cover 
(Section 5.6).

3. Remove the Mini PCI communications module (Section 5.7).

4. Remove the RTC battery from the socket on the 
system board.

Removing the RTC Battery

Reverse the above procedure to install an RTC battery.

RTC Battery Spare Part Number Information

RTC battery (includes 2-sided tape) 407816-001
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5.9 Optical Drive

1. Prepare the computer for disassembly (Section 5.3).

2. Position the computer with the left side toward you.

Optical Drive Spare Part Number Information

DVD±RW and CD-RW Double-Layer Combo Drive with 
LightScribe
DVD/CD-RW Double-Layer Combo Drive with LightScribe
DVD/CD-RW Combo Drive

403806-001

407855-001
407854-001

DVD/CD-RW Super Multi Double-Layer Combo Drive with 
LightScribe and Hitachi LG Data Storage
DVD±RW and CD-RW Double-Layer Combo Drive
DVD±RW and CD-RW Double-Layer Combo Drive with 
LightScribe

417698-001

430856-001
430857-001
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3. Remove the Phillips PM2.5×11.0 screw 1 that secures the 
optical drive to the computer.

4. Push the rear edge of the optical drive 2 to disconnect 
the drive from the system board.

5. Remove the optical drive 3.

Removing the Optical Drive
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6. If it is necesary to replace the optical drive bracket, remove 
the two Phillips PM2.0×4.0 screws 1 that secure the bracket 
to the optical drive.

7. Remove the optical drive bracket 2.

Removing the Optical Drive Bracket

Reverse the above procedure to install an optical drive.
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5.10 Switch Cover

1. Prepare the computer for disassembly (Section 5.3).

2. Remove the following screws:

1 Two Phillips PM2.5×11.0 screws

2 Three Phillips PM2.5×6.0 screws

3 Two silver Phillips PM2.5×5.0 screws

Removing the Switch Cover Screws

Switch Cover Spare Part Number Information

For use with full-featured models
For use with defeatured models

407825-001
407826-001
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3. Turn the computer display-side up with front toward you.

4. Open the computer as far as possible.

5. Insert a flat-bladed tool under the display hinge cover 1 
sections of the switch cover.

6. Lift the switch cover until the left and right sides 2 of the 
switch cover disengage from the computer.

7. Remove the switch cover.

Removing the Switch Cover

Reverse the above procedure to install the switch cover.
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5.11 Keyboard Frame

1. Prepare the computer for disassembly (Section 5.3).

2. Remove the memory/Mini PCI module compartment cover 
(Section 5.6).

3. Remove the switch cover (Section 5.10).

4. Turn the computer upside down with the rear panel 
toward you.

5. Remove the Phillips PM2.0×6.0 screw in the battery bay 
that secures the keyboard frame to the computer.

Removing the Keyboard Frame Screw

Keyboard Frame Spare Part Number Information

Keyboard frame 407786-001
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6. Turn the computer display-side up with front toward you.

7. Open the computer as far as possible.

8. Slide the keyboard frame 1 toward the back of the computer.

9. Lift and hold the rear edge of the keyboard frame 2 until the 
LED board cable connector is accessible.

Releasing the Keyboard Frame
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10. Release the zero insertion force (ZIF) connector 1 to which 
the LED board cable is connected and disconnect the 
cable 2.

Disconnecting the LED Board Cable
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11. Swing the keyboard frame 1 forward until the assembly 
rests upside down on the palm rest.

12. Release the ZIF connector to which the keyboard cable 2 is 
attached and disconnect the keyboard cable 3.

13. Remove the keyboard frame.

Removing the Keyboard Frame

Reverse the above procedure to install the keyboard frame.
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5.12 LED Board

1. Prepare the computer for disassembly (Section 5.3) and then 
remove the following components:

a. Memory/Mini PCI module compartment cover
(Section 5.6)

b. Switch cover (Section 5.10)

c. Keyboard frame (Section 5.11)

2. Turn the keyboard frame upside down with the LED board 
toward you.

LED Board Spare Part Number Information

✎ LED board spare part kits include the LED board cable.

LED board 417023-001
5–26 Maintenance and Service Guide



Removal and Replacement Procedures
3. Remove the five Phillips PM2.0×4.0 screws 1 that secure 
the LED board to the keyboard frame.

4. Remove the LED board 2.

Removing the LED Board

Reverse the above procedure to install the LED board.
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5.13 Keyboard

1. Prepare the computer for disassembly (Section 5.3).

2. Remove the switch cover (Section 5.10).

3. Remove the keyboard frame (Section 5.11).

4. Turn the keyboard assembly upside down with the LED 
board toward you.

Keyboard Spare Part Number Information

Belgium
Denmark
France
French Canada
Germany
Greece
International
Israel
Italy
Latin America

407857-A41
407857-081
407857-051
407857-121
407857-041
407857-151
407857-B31
407857-BB1
407857-061
407857-161

Norway
Portugal
Saudi Arabia
Spain
Sweden/Finland
Switzerland
Turkey
The United Kingdom
The United States

407857-091
407857-131
407857-171
407857-071
407587-B71
407857-111
407857-141
407857-031
407857-001
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Removal and Replacement Procedures
5. Remove the four Phillips PM2.0×3.0 screws 1 that secure 
the keyboard to the keyboard frame.

6. Remove the tabs on the bottom of the keyboard from the slots 
in the keyboard frame.

7. Remove the keyboard 2.

Removing the Keyboard

Reverse the above procedure to install the keyboard.
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Removal and Replacement Procedures
5.14 Display Assembly

1. Prepare the computer for disassembly (Section 5.3).

2. Remove the memory/Mini PCI module compartment cover 
(Section 5.6).

3. Disconnect the wireless antenna cables from the Mini PCI 
communications module (Section 5.7).

Display Assembly Spare Part Number Information

✎ Display assemblies include display cable, wireless antenna boards, and 
antenna cables.

15.4-inch, WXGA with BrightView
15.4-inch, WXGA with antiglare

407841-001
407839-001
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Removal and Replacement Procedures
4. Remove the switch cover (Section 5.10).

5. Remove the keyboard frame (Section 5.11).

6. Remove the keyboard (Section 5.13).

7. Disconnect the display cable 1 from the system board.

8. Remove the wireless antenna cables from the clips 2 in the 
top cover.

Disconnecting the Display and Wireless Antenna Cables
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Removal and Replacement Procedures
Ä
CAUTION: Support the display assembly when removing the following 
screws. Failure to support the display assembly can result in damage to 
the display assembly and other computer components.

9. Remove the four Phillips PM2.5×7.0 screws 1 that secure 
the display assembly to the computer.

10. Lift the display assembly straight up and remove it 2.

Removing the Display Assembly
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Removal and Replacement Procedures
Display Assembly Subcomponents

Spare Part Number Information

Display Plastics Kit, includes:

■ Display bezel

■ Display enclosure

■ Display release latch actuator and hooks

407792-001

Display Hinge Kit 407796-001

Display inverter board 407800-001

Display Panel Kit (includes display panel cable)

■ 15.4-inch, WXGA with BrightView

■ 15.4-inch, WXGA antiglare

407799-001
407798-001

Wireless Antenna Kit (includes cable and transceivers) 407791-001

Display Label Kit (not illustrated) 407864-001

Display Screw Kit (not illustrated), includes:

■ Phillips PM2.5×7.0 screws

■ Phillips PM2.0×4.0 screws

■ Rubber screw covers

407794-001
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Removal and Replacement Procedures
11. Remove the eight rubber screw covers 1 and 2 and the eight 
Phillips PM2.5×7.0 screws 3 that secure the display bezel 
to the display assembly.

✎ The rubber screw covers are included in the Display Screw Kit, 
spare part number 407794-001.

The four rubber screw covers 1 on the top edge of the display 
bezel are thicker than the four rubber screw covers 2 on the 
bottom edge of the display bezel.

Removing the Display Bezel Screws
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Removal and Replacement Procedures
✎ The display bezel and display enclosure are available in the 
Display Plastics Kit, spare part number 407792-001.

12. Flex the inside edges of the left and right sides 1 and the 
top and bottom sides 2 of the display bezel until the bezel 
disengages from the display enclosure.

13. Remove the display bezel 3.

Removing the Display Bezel
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Removal and Replacement Procedures
14. Disconnect the following cables:

1 Display panel cable

2 Wireless light cable

3 Display inverter board cable

Disconnecting the Display Panel Cables
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Removal and Replacement Procedures
15. Remove the two Phillips PM2.5×7.0 screws 1 that secure 
the display panel to the display enclosure.

16. Remove the display panel 2 and inverter board 3.

Removing the Display Panel and Inverter Board

Display Assembly Subcomponents

Spare Part Number Information

Display Panel Kit (includes display panel cable)

■ 15.4-inch, WXGA with BrightView

■ 15.4-inch, WXGA antiglare

407799-001
407798-001

Display inverter board 407800-001
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Removal and Replacement Procedures
✎ The display release hook arm and spring are available in the 
Display Hinge Kit, spare part number 407796-001.

17. If it is necessary to replace the display release hook arm, 
slide and hold the arm 1 to the right.

18. Slide the right side of the arm 2 forward until it clears the 
tab 3 on the display enclosure.

19. Lift the arm 4 out of the display enclosure.

20. Detach the display release hook arm spring 5 from the tab 
on the display enclosure.

21. Remove the display release hook arm.

Removing the Display Release Hook Arm
5–38 Maintenance and Service Guide



Removal and Replacement Procedures
✎ The display hinges are available in the Display Hinge Kit, 
spare part numbers 407796-001.

22. If it is necessary to replace the display hinges, remove the 
four Phillips PM2.0×4.0 screws 1 that secure each hinge 
to the display panel.

23. Remove the display hinges 2.

Removing the Display Hinges
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Removal and Replacement Procedures
24. Remove the Phillips PM2.0×4.0 screws 1 that secure the left 
and right wireless antenna transceivers to the display 
enclosure.

25. Release the retention tabs 2 built in to the display enclosure 
lining that secure the wireless antenna cables to the display 
enclosure.

26. Detach the wireless antenna transceivers 3 from the display 
enclosure.

27. Remove the wireless antenna transceivers and cables 4.

✎ The wireless antenna transceivers and cables are available in 
the Wireless Antenna Kit, spare part number 407791-001.

Removing the Wireless Antenna Transceivers and Cables

Reverse the above procedure to reassemble and install the 
display assembly.
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Removal and Replacement Procedures
5.15 Top Cover

1. Prepare the computer for disassembly (Section 5.3) and then 
remove the following components:

a. Hard drive (Section 5.4)

b. Memory/Mini PCI module compartment cover
(Section 5.6)

c. Optical drive (Section 5.7)

d. Switch cover (Section 5.10)

e. Keyboard assembly (Section 5.11)

f. Display assembly (Section 5.14)

Top Cover and Base Enclosure

Spare Part Number Information

Top cover (includes TouchPad)
TouchPad bracket

407822-001
407811-001

Base enclosure for use with full-featured models
Base enclosure for use with defeatured models

407813-001
407814-001
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Removal and Replacement Procedures
2. Turn the computer upside down with the front toward you.

3. Remove the two Phillips PM2.5×3.0 screws 1 in the optical 
drive bay and the silver Phillips PM2.5×5.0 screw 2 in the 
hard drive bay that secure the top cover to the computer.

Removing the Top Cover Screws, Part 1
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Removal and Replacement Procedures
4. Remove the eight Phillips PM2.5×11.0 screws that secure 
the top cover to the computer.

Removing the Top Cover Screws, Part 2
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Removal and Replacement Procedures
5. Turn the computer right-side up with the front toward you.

6. Release the ZIF connector to which the TouchPad cable 1 is 
connected and disconnect the TouchPad cable 2 from the 
system board.

✎ The TouchPad cable is included in the Cable Kit, spare part 
number 407774-001.

Disconnecting the TouchPad Cable
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Removal and Replacement Procedures
7. Remove the seven Phillips PM2.5×11.0 screws that secure 
the top cover to the computer.

Removing the Top Cover Screws, Part 3
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Removal and Replacement Procedures
8. Remove the three silver PM2.5×5.0 screws that secure the top 
cover to the computer.

Removing the Top Cover Screws, Part 4
5–46 Maintenance and Service Guide



Removal and Replacement Procedures
9. Lift up the rear edge of the top cover 1 until it disengages 
from the base enclosure.

10. Lift the top cover 2 straight up and remove it.

Removing the Top Cover
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Removal and Replacement Procedures
11. If it is necessary to replace the TouchPad cable, release the 
ZIF connector to which the TouchPad cable 1 is connected 
and disconnect the TouchPad cable 2 from the TouchPad 
board.

12. Remove the TouchPad cable .

✎ The TouchPad cable is included in the Cable Kit, spare part 
number 407774-001.

Removing the TouchPad Cable

Reverse the above procedure to install the top cover.
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Removal and Replacement Procedures
5.16 Bluetooth Module

1. Prepare the computer for disassembly (Section 5.3), 
and then remove the following components:

a. Hard drive (Section 5.4)

b. Memory/Mini PCI module compartment cover
(Section 5.6)

c. Optical drive (Section 5.9)

d. Switch cover (Section 5.10)

e. Keyboard assembly (Section 5.11)

f. Display assembly (Section 5.14)

g. Top cover (Section 5.15)

Bluetooth Module Spare Part Number Information

Bluetooth module (includes Bluetooth module cable) 397922-001
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Removal and Replacement Procedures
2. Remove the Phillips PM2.0×4.0 screw 1 that secures the 
Bluetooth module to the base enclosure.

3. Remove the Bluetooth module from the base enclosure 2.

4. Remove the Bluetooth module cable 3 from the routing 
channel in the base enclosure.

5. Disconnect the Bluetooth module cable 4 from the Bluetooth 
module.

✎ The Bluetooth module cable is included with the Bluetooth 
module and is also available in the Cable Kit, spare part 
number 407774-001.

Removing the Bluetooth module

Reverse the above procedure to install the Bluetooth board.
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Removal and Replacement Procedures
5.17 System Board

✎ When replacing the system board, ensure that the following 
components are removed from the defective system board and 
installed on the replacement system board:
■ Memory modules (Section 5.6)
■ Mini PCI communications module (Section 5.7)
■ RTC battery (Section 5.8)
■ Power connector and cable (Section 5.17)
■ Heat sink (Section 5.19)
■ Processor (Section 5.20)
■ Fan assembly (Section 5.21)
■ Fan assembly (Section 5.22)
■ PC Card assembly (Section 5.23)

1. Prepare the computer for disassembly (Section 5.3), 
and then remove the following components:

a. Hard drive (Section 5.4)

b. Optical drive (Section 5.9)

c. Switch cover (Section 5.10)

d. Keyboard assembly (Section 5.11)

e. Display assembly (Section 5.14)

f. Top cover (Section 5.15)

g. Bluetooth module(Section 5.16)

System Board Spare Part Number Information

For use with full-featured models
For use with defeatured models

417021-001
417022-001
Maintenance and Service Guide 5–51



Removal and Replacement Procedures
2. Turn the computer right-side up with the front toward you.

3. Press in on the ExpressCard slot bezel 1 to release it.

4. Remove the ExpressCard slot bezel 2.

✎ The ExpressCard slot bezel is included in the Plastics Kit, 
spare part number 407778-001.

Removing the ExpressCard Slot Bezel
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Removal and Replacement Procedures
5. Remove the PM2.5×6.0 screw 1 that secures the display 
hinge support to the base enclosure.

6. Remove the display hinge support 2.

7. Remove the power connector 3 from the clip in the 
base enclosure.

8. Remove the power connector cable 4 from the clips in 
the base enclosure.

✎ The display hinge support is included in the Bracket Kit, spare 
part number 407820-001.

Removing the Display Hinge Support and Power Connector
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Removal and Replacement Procedures
9. Disconnect the USB/audio board cable 1 and modem 
cable 2 from the system board.

Disconnecting the Modem and USB/Audio Board Cables
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Removal and Replacement Procedures
10. Remove the two Phillips PM2.5×11.0 screws 1 and the three 
Phillips PM2.5×6.0 screws 2 that secure the system board 
to the base enclosure.

11. Remove the ExpressCard bracket 3.

✎ The ExpressCard bracket is included in the Bracket Kit, spare 
part number 407820-001.

Removing the System Board Screws
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Removal and Replacement Procedures
12. Use the optical drive connector 1 to lift the right side of the 
system board 2 until it is clear of the base enclosure.

13. Slide the system board 3 to the right at an angle and 
remove it.

Removing the System Board
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Removal and Replacement Procedures
14. If it is necessary to replace the power connector cable, turn 
the system board upside down with the expansion port 2 
docking connector toward you.

15. Disconnect the power connector cable 1 from the system 
board.

16. Remove the power connector cable 2.

✎ The power connector cable is available in the Cable Kit, spare 
part number 407774-001, and is also available using spare part 
number 415495-001.

Removing the Power Connector Cable
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Removal and Replacement Procedures
17. If it is necessary to replace the modem connector and cable, 
remove the modem connector 1 and cable 2 from the clips 
and routing channel in the base enclosure.

✎ The modem connector and cable is available in the Cable Kit, 
spare part number 407774-001.

Removing the Modem Connector and Cable
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Removal and Replacement Procedures
5.18 USB/Audio Board

1. Prepare the computer for disassembly (Section 5.3), 
and then remove the following components:

a. Hard drive (Section 5.4)

b. Optical drive (Section 5.9)

c. Switch cover (Section 5.10)

d. Keyboard assembly (Section 5.11)

e. Display assembly (Section 5.14)

f. Top cover (Section 5.15)

g. System board (Section 5.17)

USB/Audio Board Spare Part Number Information

✎ USB/audio boards include USB/audio board cable.

For use with full-featured models
For use with defeatured models

417025-001
417026-001
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Removal and Replacement Procedures
2. Remove the Phillips PM2.5×6.0 screw 1 that secures the 
USB/audio board to the base enclosure.

3. Remove the USB/audio board 2 from the base enclosure.

4. Disconnect the USB/audio board cable 3 from the 
USB/audio board.

✎ The USB/audio board cable is available in the Cable Kit, spare 
part number 407774-001.

Removing the USB/Audio Board

Reverse the above procedure to install the USB/audio board.
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Removal and Replacement Procedures
5.19 Heat Sink

1. Prepare the computer for disassembly (Section 5.3), 
and then remove the following components:

a. Hard drive (Section 5.4)

b. Memory/Mini PCI module compartment cover
(Section 5.6)

c. Optical drive (Section 5.9)

d. Switch cover (Section 5.10)

e. Keyboard assembly (Section 5.11)

f. Display assembly (Section 5.14)

g. Top cover (Section 5.15)

h. System board (Section 5.17)

Heat Sink Spare Part Number Information

Heat sink (includes thermal paste)
Thermal paste

403827-001
407817-001
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Removal and Replacement Procedures
2. Turn the system board upside down with the expansion port 2 
toward you.

3. Remove the four Phillips PM2.5×6.0 screws 1 that secure the 
heat sink to the system board.

4. Remove the heat sink 2.

✎ Due to the adhesive quality of the thermal paste located 
between the fan assembly and processor 3, it may be 
necessary to move the fan assembly from side to side to detach 
the it from the processor.

Removing the Heat Sink
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Removal and Replacement Procedures
✎ The thermal paste should be thoroughly cleaned from the 
surfaces of the heat sink 1 and processor 2 each time the heat 
sink is removed. Thermal paste should be reapplied to both 
surfaces before the heat sink is reinstalled. Thermal paste is 
included with all heat sink and processor spare part kits.

Replacing the Thermal Paste

Reverse the above procedure to install the fan assembly.
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Removal and Replacement Procedures
5.20 Processor

✎ The computer may be equipped with a processor socket that 
features either a locking screw or a release arm. Both types of 
sockets are documented in this section.

Processor Spare Part Number Information

✎ All processor spare part kits include thermal paste.

AMD Turion 64 ML-40 (2.2-GHz)
AMD Turion 64 ML-40 (2.2-GHz)
AMD Turion 64 ML-37 (2.0-GHz)
AMD Turion 64 ML-34 (1.8-GHz)
AMD Turion 64 ML-32 (1.8-GHz)

430499-001
393579-001
393578-001
407836-001
395744-001

Mobile AMD Sempron M3300 (2.0-GHz)
Mobile AMD Sempron M3100 (1.8-GHz)
Mobile AMD Sempron M3000 (1.8-GHz)

407837-001
430855-001
407838-001

Thermal paste 407817-001
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Removal and Replacement Procedures
1. Prepare the computer for disassembly (Section 5.3), 
and then remove the following components:

a. Hard drive (Section 5.4)

b. Memory/Mini PCI module compartment cover
(Section 5.6)

c. Optical drive (Section 5.9)

d. Switch cover (Section 5.10)

e. Keyboard assembly (Section 5.11)

f. Display assembly (Section 5.14)

g. Top cover (Section 5.15)

h. System board (Section 5.17)

i. Heat sink (Section 5.19)
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Removal and Replacement Procedures
✎ Steps 2 and 3 apply to processor sockets equipped with a 
locking screw. Refer to steps 4 through 6 for instructions 
on removing a processor from a socket equipped with a 
release arm.

2. Use a flat-bladed screwdriver to turn the processor locking 
screw 1 one-quarter turn counterclockwise until you hear 
a click.

3. Lift the processor 2 straight up and remove it.

✎ The gold triangle 3 on the processor should be aligned in the 
rear right corner when you install the processor.

Removing the Processor from a Socket with a Locking Screw
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Removal and Replacement Procedures
✎ Steps 4 through 6 apply to processor sockets equipped with a 
release arm.

4. Slide the tip of the processor socket release arm 1 to the right 
until it clears the notch 2 on the processor socket.

5. Swing the processor socket release arm 3 up and back as 
far as it will go.

6. Lift the processor straight up and remove it 4.

✎ The gold triangle 5 on the processor should be aligned in the 
front left corner when you install the processor.

Removing the Processor from a Socket with a Release Arm

Reverse the above procedure to install the processor.
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Removal and Replacement Procedures
5.21 Fan Assembly

1. Prepare the computer for disassembly (Section 5.3), 
and then remove the following components:

a. Hard drive (Section 5.4)

b. Memory/Mini PCI module compartment cover
(Section 5.6)

c. Optical drive (Section 5.9)

d. Switch cover (Section 5.10)

e. Keyboard assembly (Section 5.11)

f. Display assembly (Section 5.14)

g. Top cover (Section 5.15)

h. System board (Section 5.17)

i. Heat sink (Section 5.19)

Fan Assembly Spare Part Number Information

Fan assembly 407807-001
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Removal and Replacement Procedures
2. Disconnect the fan cable 1 from the system board.

3. Remove the following screws:

2 One Phillips PM2.5×3.0 screw that secures the expansion 
port 2 bracket to the system board

3 Two slotted M1.5×9.0 screws on each side of the 
expansion port 2 connector that secure the expansion 
port 2 bracket to the system board

4 Two Phillips PM3.0×6.0 screws on each side of the 
external monitor connector that secure the fan assembly 
to the system board

Removing the Fan Assembly Screws
Maintenance and Service Guide 5–69



Removal and Replacement Procedures
4. Slide the expansion port bracket 1 away from the system 
board.

5. Remove the fan assembly 2.

Removing the Fan Assembly

Reverse the above procedure to install the fan assembly.
5–70 Maintenance and Service Guide



Removal and Replacement Procedures
5.22 Speakers

1. Prepare the computer for disassembly (Section 5.3), 
and then remove the following components:

a. Hard drive (Section 5.4)

b. Memory/Mini PCI module compartment cover
(Section 5.6)

c. Optical drive (Section 5.9)

d. Switch cover (Section 5.10)

e. Keyboard assembly (Section 5.11)

f. Display assembly (Section 5.14)

g. Top cover (Section 5.15)

h. System board (Section 5.17)

i. Fan assembly (Section 5.20)

Speaker Spare Part Number Information

Speakers 407784-001
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Removal and Replacement Procedures
2. Turn the system board right-side up with the expansion port 2 
toward you.

3. Disconnect the speaker cable 1 from the system board.

4. Remove the PM2.5×6.0 screw 2 that secures the speaker 
to the system board.

5. Slide the speaker 3 forward and remove it from the 
system board.

Removing the Speaker

Reverse the above procedure to install the speaker.
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Removal and Replacement Procedures
5.23 PC Card Assembly

1. Prepare the computer for disassembly (Section 5.3), 
and then remove the following components:

a. Hard drive (Section 5.4)

b. Memory/Mini PCI module compartment cover
(Section 5.6)

c. Optical drive (Section 5.9)

d. Switch cover (Section 5.10)

e. Keyboard assembly (Section 5.11)

f. Display assembly (Section 5.14)

g. Top cover (Section 5.15)

h. System board (Section 5.17)

PC Card Assembly Spare Part Number Information

PC Card assembly 407829-001
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Removal and Replacement Procedures
2. Turn the system board upside down with the expansion port 2 
toward you.

3. Remove the two PM2.0×4.0 screws that secure the PC Card 
assembly to the system board.

Removing the PC Card Assembly Screws
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Removal and Replacement Procedures
4. Turn the system board right-side up with the expansion port 2 
toward you.

5. Disengage the hooks 1 on the PC Card assembly from the 
slots on the PC Card connector 2.

6. Remove the PC Card assembly from the system board 3.

Removing the PC Card Assembly

Reverse the above procedures to install the PC Card assembly.
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Removal and Replacement Procedures
5.24 ExpressCard Assembly

1. Prepare the computer for disassembly (Section 5.3), 
and then remove the following components:

a. Hard drive (Section 5.4)

b. Memory/Mini PCI module compartment cover
(Section 5.6)

c. Optical drive (Section 5.9)

d. Switch cover (Section 5.10)

e. Keyboard assembly (Section 5.11)

f. Display assembly (Section 5.14)

g. Top cover (Section 5.15)

h. System board (Section 5.17)

ExpressCard Assembly Spare Part Number Information

ExpressCard assembly 407809-001
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Removal and Replacement Procedures
2. Turn the system board upside down with the expansion port 2 
toward you.

3. Remove the two PM2.0×4.0 screws that secure the 
ExpressCard assembly to the system board.

Removing the ExpressCard Assembly Screws
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Removal and Replacement Procedures
4. Turn the system board right-side up with the expansion port 2 
toward you.

5. Remove the ExpressCard assembly from the system board.

Removing the ExpressCard Assembly

Reverse the above procedures to install the ExpressCard 
assembly.
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6
Specifications

This chapter provides physical and performance specifications.

Table 6-1

Computer

Dimensions Metric U.S.

Height
Front
Rear
Width
Depth

3.50 cm
4.50 cm
35.79 cm
26.39 cm

1.38 in
1.77 in
14.09 in
10.39 in

Weight
With 17.0-inch display, optical drive 

and 8-cell battery
2.99 kg 6.60 lbs

Input Power

Operating voltage
Operating current

18.5 V dc to 19.0 V dc
4.74 A or 4.9 A

Temperature

Operating
Nonoperating

10°C to 35°C
-20°C to 60°C

50°F to 95°F
-4°F to 140°F
Maintenance and Service Guide 6–1



Specifications
Relative humidity (noncondensing)

Operating
Nonoperating

10% to 90%
5% to 95%

10% to 90%
5% to 95%

Maximum altitude (unpressurized)

Operating (14.7 to 10.1 psia)
Nonoperating (14.7 to 4.4 psia)

-15 m to 3,048 m
-15 m to 12,192 m

-50 ft to 10,000 ft
-50 ft to 40,000 ft

Shock

Operating
Nonoperating

125 g, 2 ms, half-sine
200 g, 2 ms, half-sine

Random Vibration

Operating

Nonoperating

0.75 g zero-to-peak, 10 Hz to 500 Hz, 
0.25 oct/min sweep rate
1.50 g zero-to-peak, 10 Hz to 500 Hz, 
0.5 oct/min sweep rate

✎ Applicable product safety standards specify thermal limits for plastic 
surfaces. The computer operates well within this range of temperatures.

Table 6-1

Computer (Continued)
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Specifications
Table 6-2

15.4-inch, WXGA, Display

Dimensions

Height
Width
Diagonal

20.7 cm
33.1 cm
39.1 cm

8.15 in
13.03 in
15.39 in

Number of colors Up to 16.8 million

Contrast ratio 200:1

Brightness 180 nits typical

Pixel resolution

Pitch
Format
Configuration

0.259 × 0.259 mm
1280 × 800
RGB vertical stripe

Backlight Edge lit

Character display 80 × 25

Total power consumption 4 W

Viewing angle +/-65° horizontal, +50° vertical typical
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Specifications
Table 6-3

Hard Drives

120-GB* 100-GB* 80-GB*

Dimensions

Height
Width
Weight

9.5 mm
70 mm
102 g

9.5 mm
70 mm
102 g

9.5 mm
70 mm
99 g

Interface type ATA-5 ATA-5 ATA-5

Transfer rate

Synchronous (maximum)
Security

100 MB/sec
ATA security

100 MB/sec
ATA security

100 MB/sec
ATA security

Seek times (typical read, including setting)

Single track
Average
Maximum

3 ms
13 ms
24 ms

3 ms
13 ms
24 ms

3 ms
13 ms
24 ms

Logical blocks† 234,428,430 195,364,233 156,301,488

Disc rotational speed 4200 rpm 4200 rpm 5400 rpm

Operating temperature 5°C to 55°C (41°F to 131°F)

✎ Certain restrictions and exclusions apply. Consult Customer Care 
for details.

*1 GB = 1 billion bytes when referring to hard drive storage capacity. Actual 
accessible capacity is less.
†Actual drive specifications may differ slightly.
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Specifications
80-GB* 60-GB* 40-GB*

Dimensions

Height
Width
Weight

9.5 mm
70 mm
99 g

9.5 mm
70 mm
99 g

9.5 mm
70 mm
99 g

Interface type ATA-5 ATA-5 ATA-5

Transfer rate

Synchronous (maximum)
Security

100 MB/sec
ATA security

100 MB/sec
ATA security

100 MB/sec
ATA security

Seek times (typical read, including setting)

Single track
Average
Maximum

3 ms
13 ms
24 ms

3 ms
13 ms
24 ms

3 ms
13 ms
24 ms

Logical blocks† 156,301,488 117,210,240 78,140,160

Disc rotational speed 4200 rpm 4200 rpm 4200 rpm

Operating temperature 5°C to 55°C (41°F to 131°F)

✎ Certain restrictions and exclusions apply. Consult Customer Care 
for details.

*1 GB = 1 billion bytes when referring to hard drive storage capacity. Actual 
accessible capacity is less.
†Actual drive specifications may differ slightly.

Table 6-3

Hard Drives (Continued)
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Specifications
Table 6-4

DVD/CD-RW Combo Drive

Applicable disc Read:
DVD-R, DVD-RW, DVD-ROM (DVD-5, 
DVD-9, DVD-10, DVD-18), CD-ROM 
(Mode 1 and 2) CD Digital Audio, 
CD-XA ready (Mode 2, Form 1 and 
2), CD-I ready (Mode 2, Form 1 and 
2), CD-R, CD-RW, Photo CD (single 
and multisession), and CD-Bridge

Write:
CD-R and CD-RW

Center hole 
diameter

1.5 cm (0.59 in)

Disc diameter

Standard disc
Mini disc

12 cm (4.72 in)
8 cm (3.15 in)

Disc thickness 1.2 mm (0.047 in)

Track pitch 0.74 µm
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Specifications
Access time CD media DVD media

Random
Full stroke

< 110 ms
< 210 ms

< 130 ms
< 225 ms

Audio output 
level

Line-out, 0.7 V rms

Cache buffer 2 MB

Data transfer rate

CD-R (24X)
CD-RW (10X)
CD-ROM (24X)
DVD (8X)
Multiword DMA 
mode 2

3600 KB/s (150 KB/s at 1X CD rate)
1500 KB/s (150 KB/s at 1X CD rate)
3600 KB/s (150 KB/s at 1X CD rate)
10,800 KB/s (1352 KB/s at 1X DVD rate)
16.6 MB/s

Startup time < 15 seconds

Stop time < 6 seconds

Table 6-4

DVD/CD-RW Combo Drive (Continued)
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Specifications
Table 6-5

DVD±RW and CD-RW Double-Layer Combo Drive

Applicable disc Read:
DVD-R, DVD-RW, DVD-ROM (DVD-5, 
DVD-9, DVD-10, DVD-18), CD-ROM 
(Mode 1 and 2), CD Digital Audio, 
CD-XA ready (Mode 2, Form 1 and 
2), CD-I ready (Mode 2, Form 1 and 
2), CD-R, CD-RW, Photo CD (single 
and multisession), CD-Bridge

Write:
CD-R and CD-RW
DVD-R and 
DVD-RW

Center hole 
diameter

1.5 cm (0.59 in)

Disc diameter

Standard disc
Mini disc

12 cm (4.72 in)
8 cm (3.15 in)

Disc thickness 1.2 mm (0.047 in)

Track pitch 0.74 µm
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Specifications
Access time CD DVD

Random
Full stroke

< 175 ms
< 285 ms

< 230 ms
< 335 ms

Audio output 
level

Audio-out, 0.7 Vrms

Cache buffer 2 MB

Data transfer rate

CD-R (16X)
CD-RW (8X)
CD-ROM (24X)
DVD (8X)
DVD-R (4X)
DVD-RW (2X)
Multiword DMA 
mode 2

2,400 KB/s (150 KB/s at 1X CD rate)
1,200 KB/s (150 KB/s at 1X CD rate)
3,600 KB/s (150 KB/s at 1X CD rate)
10,800 KB/s (1,352 KB/s at 1X DVD rate)
5,400 KB/s (1,352 KB/s at 1X DVD rate)
2,700 KB/s (1,352 KB/s at 1X DVD rate)
16.6 MB/s

Startup time < 15 seconds

Stop time < 6 seconds

Table 6-5

DVD±RW and CD-RW Double-Layer Combo Drive (Continued)
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Specifications
Table 6-6

System Interrupts

Hardware IRQ System Function

IRQ0 System timer

IRQ1 Standard 101-/102-Key or Microsoft Natural Keyboard

IRQ2 Cascaded

IRQ3 USB2 Enhanced Host Controller—24CD

IRQ4 COM1

IRQ5* Conexant AC—Link Audio
Data Fax Modem with SmartCP 

IRQ6 Diskette drive

IRQ7* Parallel port

IRQ8 System CMOS/real-time clock

IRQ9* Microsoft ACPI-compliant system

IRQ10* Realtek RTL8139 Family PCI fast Ethernet Controller
6–10 Maintenance and Service Guide



Specifications
IRQ11 TI OHCI 1394 host controller
TI PCI1410 CardBus controller

IRQ12 Synaptics PS/2 TouchPad

IRQ13 Numeric data processor

IRQ14 Primary IDE channel

IRQ15 Secondary IDE channel

*Default configuration; audio possible configurations are IRQ5, IRQ7, IRQ9, 
IRQ10, or none.

✎ PC Cards may assert IRQ3, IRQ4, IRQ5, IRQ7, IRQ9, IRQ10, IRQ11, or 
IRQ15. Either the infrared or the serial port may assert IRQ3 or IRQ4.

Table 6-6

System Interrupts (Continued)
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Specifications
Table 6-7

System I/O Addresses

I/O Address (hex) System Function (shipping configuration)

000 - 00F DMA controller no. 1

010 - 01F Unused

020 - 021 Interrupt controller no. 1

022 - 024 Opti chipset configuration registers

025 - 03F Unused

02E - 02F 87334 “Super I/O” configuration for CPU

040 - 05F Counter/timer registers

044 - 05F Unused

060 Keyboard controller

061 Port B

062 - 063 Unused

064 Keyboard controller

065 - 06F Unused

070 - 071 NMI enable/RTC

072 - 07F Unused

080 - 08F DMA page registers

090 - 091 Unused

092 Port A

093 - 09F Unused

0A0 - 0A1 Interrupt controller no. 2
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Specifications
I/O Address (hex) System Function (shipping configuration)

0A2 - 0BF Unused

0C0 - 0DF DMA controller no. 2

0E0 - 0EF Unused

0F0 - 0F1 Coprocessor busy clear/reset

0F2 - 0FF Unused

100 - 16F Unused

170 - 177 Secondary fixed disk controller

178 - 1EF Unused

1F0 - 1F7 Primary fixed disk controller

1F8 - 200 Unused

201 Joystick (decoded in ESS1688)

202 - 21F Unused

220 - 22F Entertainment audio

230 - 26D Unused

26E - 26 Unused

278 - 27F Unused

280 - 2AB Unused

2A0 - 2A7 Unused

2A8 - 2E7 Unused

2E8 - 2EF Reserved serial port

Table 6-7

System I/O Addresses (Continued)
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Specifications
I/O Address (hex) System Function (shipping configuration)

2F0 - 2F7 Unused

2F8 - 2FF Infrared port

300 - 31F Unused

320 - 36F Unused

370 - 377 Secondary diskette drive controller

378 - 37F Parallel port (LPT1/default)

380 - 387 Unused

388 - 38B FM synthesizer—OPL3

38C - 3AF Unused

3B0 - 3BB VGA

3BC - 3BF Reserved (parallel port/no EPP support)

3C0 - 3DF VGA

3E0 - 3E1 PC Card controller in CPU

3E2 - 3E3 Unused

3E8 - 3EF Internal modem

3F0 - 3F7 “A” diskette controller

3F8 - 3FF Serial port (COM1/default)

CF8 - CFB PCI configuration index register (PCIDIVO-1)

CFC - CFF PCI configuration data register (PCIDIVO-1)

Table 6-7

System I/O Addresses (Continued)
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Specifications
Table 6-8

System Memory Map

Size Memory Address System Function

640 KB 00000000-0009FFFF Base memory

128 KB 000A0000-000BFFFF Video memory

48 KB 000C0000-000CBFFF Video BIOS

160 KB 000C8000-000E7FFF Unused

64 KB 000E8000-000FFFFF System BIOS

15 MB 00100000-00FFFFFF Extended memory

58 MB 01000000-047FFFFF Super extended memory

58 MB 04800000-07FFFFFF Unused

2 MB 08000000-080FFFFF Video memory (direct access)

4 GB 08200000-FFFEFFFF Unused

64 KB FFFF0000-FFFFFFFF System BIOS
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Specifications
Table 6-9

System DMA

Hardware DMA System Function

DMA0 Not applicable

DMA1* Not applicable

DMA2* Not applicable

DMA3 Not applicable

DMA4 Direct memory access controller

DMA5* Available for PC Card

DMA6 Not assigned

DMA7 Not assigned

*PC Card controller can use DMA 1, 2, or 5.
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A
 Screw Listing

This appendix provides specification and reference information 
for the screws and screw locks used in the computer. All screws 
listed in this appendix are available in the Computer Screw Kit, 
spare part number 407782-001, and the Display Screw Kit, spare 
part number 407794-001.

Phillips PM3.0×3.0 Screw Locations

Table A-1

Phillips PM3.0×3.0 Screw

Color Qty. Length Thread
Head 
Width

Black 4 3.0 mm 3.0 mm 5.0 mm

Where used:
4 screws that secure the hard drive frame to the hard drive (documented in 
Section 5.4)

mm
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Screw Listing
Black Phillips PM2.5×5.0 Screw Locations

Table A-2

Black Phillips PM2.5×5.0 Screw

Color Qty. Length Thread
Head 
Width

Black 4 5.0 mm 2.5 mm 6.0 mm

Where used:
1 Two screws that secure the hard drive cover to the computer (screws are 
captured on the cover by C-clips; documented in Section 5.4)
2 Two screws that secure the memory/Mini PCI module compartment cover 
to the computer (screws are captured on the cover by C-clips; documented in
Section 5.6)

mm
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Screw Listing
Phillips PM2.5×6.0 Screw Locations

Table A-3

Phillips PM2.5×6.0 Screw

Color Qty. Length Thread
Head 
Width

Black 15 6.0 mm 2.5 mm 6.0 mm

Where used:
2 screws that secure the hard drive to the computer (documented in
Section 5.4)

mm
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Screw Listing
Phillips PM2.5×6.0 Screw Locations

Table A-3

Phillips PM2.5×6.0 Screw (Continued)

Color Qty. Length Thread
Head 
Width

Black 15 6.0 mm 2.5 mm 6.0 mm

Where used:
3 screws that secure the switch cover to the computer (documented in
Section 5.10)

mm
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Screw Listing
Phillips PM2.5×6.0 Screw Location

Table A-3

Phillips PM2.5×6.0 Screw (Continued)

Color Qty. Length Thread
Head 
Width

Black 15 6.0 mm 2.5 mm 6.0 mm

Where used:
One screw that secures the display hinge support to the base enclosure 
(documented in Section 5.17)

mm
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Screw Listing
Phillips PM2.5×6.0 Screw Locations

Table A-3

Phillips PM2.5×6.0 Screw (Continued)

Color Qty. Length Thread
Head 
Width

Black 15 6.0 mm 2.5 mm 6.0 mm

Where used:
3 screws that secure the top cover to the computer (documented in
Section 5.15)

mm
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Screw Listing
Phillips PM2.5×6.0 Screw Location

Table A-3

Phillips PM2.5×6.0 Screw (Continued)

Color Qty. Length Thread
Head 
Width

Black 15 6.0 mm 2.5 mm 6.0 mm

Where used:
1 screw that secures the USB/audio board to the base enclosure (documented 
in Section 5.18)

mm
Maintenance and Service Guide A–7



Screw Listing
Phillips PM2.5×6.0 Screw Locations

Table A-3

Phillips PM2.5×6.0 Screw (Continued)

Color Qty. Length Thread
Head 
Width

Black 15 6.0 mm 2.5 mm 6.0 mm

Where used:
4 screws that secure the heat sink to the system board (documented in
Section 5.19)

mm
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Screw Listing
Phillips PM2.5×6.0 Screw Location

Table A-3

Phillips PM2.5×6.0 Screw (Continued)

Color Qty. Length Thread
Head 
Width

Black 15 6.0 mm 2.5 mm 6.0 mm

Where used:
One screw that secures the speakers to the system board (documented in
Section 5.22)

mm
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Screw Listing
Phillips PM2.5×3.0 Screw Locations

Table A-4

Phillips PM2.5×3.0 Screw

Color Qty. Length Thread
Head 
Width

Black 5 3.0 mm 2.5 mm 6.0 mm

Where used:
2 screws that secure the memory shield to the computer (documented in
Section 5.6)

mm
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Screw Listing
Phillips PM2.5×3.0 Screw Locations

Table A-4

Phillips PM2.5×3.0 Screw (Continued)

Color Qty. Length Thread
Head 
Width

Black 5 3.0 mm 2.5 mm 6.0 mm

Where used:
2 screws that secure the top cover to the computer (documented in
Section 5.15)

mm
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Screw Listing
Phillips PM2.5×3.0 Screw Location

Table A-4

Phillips PM2.5×3.0 Screw (Continued)

Color Qty. Length Thread
Head 
Width

Black 5 3.0 mm 2.5 mm 6.0 mm

Where used:
One screw that secures the fan assembly to the system board (documented in
Section 5.21)

mm
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Screw Listing
Phillips PM2.5×11.0 Screw Locations

Table A-5

Phillips PM2.5×11.0 Screw

Color Qty. Length Thread
Head 
Width

Black 20 11.0 mm 2.5 mm 6.0 mm

Where used:
1 One screw that secures the optical drive to the computer (documented in
Section 5.9)
2 Two screws that secure the switch cover to the computer (documented in
Section 5.10)

mm
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Screw Listing
Phillips PM2.5×11.0 Screw Locations

Table A-5

Phillips PM2.5×11.0 Screw (Continued)

Color Qty. Length Thread
Head 
Width

Black 20 11.0 mm 2.5 mm 6.0 mm

Where used:
8 screws that secure the top cover to the computer (documented in
Section 5.15)

mm
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Screw Listing
Phillips PM2.5×11.0 Screw Locations

Table A-5

Phillips PM2.5×11.0 Screw (Continued)

Color Qty. Length Thread
Head 
Width

Black 20 11.0 mm 2.5 mm 6.0 mm

Where used:
7 screws that secure the top cover to the computer (documented in
Section 5.15)

mm
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Screw Listing
Phillips PM2.5×11.0 Screw Locations

Table A-5

Phillips PM2.5×11.0 Screw (Continued)

Color Qty. Length Thread
Head 
Width

Black 20 11.0 mm 2.5 mm 6.0 mm

Where used:
2 screws that secure the system board to the base enclosure (documented in
Section 5.17)

mm
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Screw Listing
Phillips PM2.0×4.0 Screw Locations

Table A-6

Phillips PM2.0×4.0 Screw

Color Qty. Length Thread
Head 
Width

Black 22 4.0 mm 2.0 mm 5.0 mm

Where used:
2 screws that secure the optical drive bracket to the optical drive (documented in 
Section 5.9)

mm
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Screw Listing
Phillips PM2.0×4.0 Screw Locations

Table A-6

Phillips PM2.0×4.0 Screw (Continued)

Color Qty. Length Thread
Head 
Width

Black 22 4.0 mm 2.0 mm 5.0 mm

Where used:
5 screws that secure the LED board to the keyboard frame (documented in 
Section 5.14)

mm
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Screw Listing
Phillips PM2.0×4.0 Screw Locations

Table A-6

Phillips PM2.0×4.0 Screw (Continued)

Color Qty. Length Thread
Head 
Width

Black 22 4.0 mm 2.0 mm 5.0 mm

Where used:
8 screws that secure the display hinges to the display panel (documented in
Section 5.14)

mm
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Screw Listing
Phillips PM2.0×4.0 Screw Locations

Table A-6

Phillips PM2.0×4.0 Screw (Continued)

Color Qty. Length Thread
Head 
Width

Black 22 4.0 mm 2.0 mm 5.0 mm

Where used:
2 screws that secure the wireless transceivers to the display enclosure 
(documented in Section 5.14)

mm
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Screw Listing
Phillips PM2.0×4.0 Screw Location

Table A-6

Phillips PM2.0×4.0 Screw (Continued)

Color Qty. Length Thread
Head 
Width

Black 22 4.0 mm 2.0 mm 5.0 mm

Where used:
One screw that secures the Bluetooth module to the display hinge support 
(documented in Section 5.16)

mm
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Screw Listing
Phillips PM2.0×4.0 Screw Locations

Table A-6

Phillips PM2.0×4.0 Screw (Continued)

Color Qty. Length Thread
Head 
Width

Black 22 4.0 mm 2.0 mm 5.0 mm

Where used:
1 Two screws that secure the PC Card assembly to the system board 
(documented in Section 5.23)
2 Two screws that secure the ExpressCard assembly to the system board 
(documented in Section 5.24)

mm
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Screw Listing
Silver Phillips PM2.5×5.0 Screw Locations

Table A-7

Silver Phillips PM2.5×5.0 Screw

Color Qty. Length Thread
Head 
Width

Silver 6 5.0 mm 2.5 mm 5.0 mm

Where used:
2 screws that secure the switch cover to the computer (documented in
Section 5.10)

mm
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Screw Listing
Silver Phillips PM2.5×5.0 Screw Location

Table A-7

Silver Phillips PM2.5×5.0 Screw (Continued)

Color Qty. Length Thread
Head 
Width

Silver 6 5.0 mm 2.5 mm 5.0 mm

Where used:
One screw that secures the top cover to the computer (documented in
Section 5.15)

mm
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Screw Listing
Silver Phillips PM2.5×5.0 Screw Locations

Table A-7

Silver Phillips PM2.5×5.0 Screw (Continued)

Color Qty. Length Thread
Head 
Width

Silver 6 5.0 mm 2.5 mm 5.0 mm

Where used:
3 screws that secure the top cover to the computer (documented in
Section 5.15)

mm
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Screw Listing
Phillips PM2.0×6.0 Screw Location

Table A-8

Phillips PM2.0×6.0 Screw

Color Qty. Length Thread
Head 
Width

Silver 1 6.0 mm 2.0 mm 5.0 mm

Where used:
One screw that secures the keyboard frame to the computer (documented in
Section 5.11)

mm
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Screw Listing
Phillips PM2.0×3.0 Screw Locations

Table A-9

Phillips PM2.0×3.0 Screw

Color Qty. Length Thread
Head 
Width

Silver 4 3.0 mm 2.0 mm 5.0 mm

Where used:
4 screws that secure the keyboard to the keyboard frame (documented in
Section 5.13)

mm
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Screw Listing
Phillips PM2.5×7.0 Screw Locations

Table A-10

Phillips PM2.5×7.0 Screw

Color Qty. Length Thread
Head 
Width

Silver 14 7.0 mm 2.5 mm 5.0 mm

Where used:
4 screws that secure the display assembly to the computer (documented in
Section 5.14)

mm
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Screw Listing
Phillips PM2.5×7.0 Screw Locations

Table A-10

Phillips PM2.5×7.0 Screw (Continued)

Color Qty. Length Thread
Head 
Width

Silver 14 7.0 mm 2.5 mm 5.0 mm

Where used:
8 screws that secure the display bezel to the display enclosure (documented in 
Section 5.14)

mm
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Screw Listing
Phillips PM2.5×7.0 Screw Locations

Table A-10

Phillips PM2.5×7.0 Screw (Continued)

Color Qty. Length Thread
Head 
Width

Silver 14 7.0 mm 2.5 mm 5.0 mm

Where used:
2 screws that secure the display panel to the display enclosure (documented in
Section 5.14)

mm
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Screw Listing
Slotted SM1.5×9.0 Screw Locations

Table A-11

Slotted SM1.5×9.0 Screw

Color Qty. Length Thread
Head 
Width

Silver 2 9.0 mm 1.5 mm 2.0 mm

Where used:
2 screws that secure the expansion port 2 bracket and fan assembly to 
the system board (documented in Section 5.21)

mm
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Screw Listing
Phillips PM3.0×6.0 Screw Locations

Table A-12

Phillips PM3.0×6.0 Screw

Color Qty. Length Thread
Head 
Width

Black 2 6.0 mm 3.0 mm 5.0 mm

Where used:
2 screws that secure the fan assembly to the system board (documented in
Section 5.21)

mm
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B
Software Update

and Recovery

Updating Software
Updated versions of the software provided with your computer 
may be available on the HP Web site.

Most software and BIOS updates on the HP Web site are 
packaged in compressed files called SoftPaqs.

Some download packages contain a file named Readme.txt, 
which contains information regarding installing and 
troubleshooting the file.

To update the software:

1. Identify your computer model, product category, and series 
or family. Prepare for a system BIOS update by identifying 
the BIOS version currently installed on the computer.

If your computer is connected to a network, consult the 
network administrator before installing any software updates, 
especially system BIOS updates.

✎ The computer system BIOS is stored on the system ROM. The 
BIOS initializes the operating system, determines how the 
computer will interact with the hardware devices, and provides 
for data transfer among hardware devices, including the time 
and date.

2. Access the updates by visiting the HP Web site at 
http://www.hp.com.

3. Install the updates.
Maintenance and Service Guide B–1

http://www.hp.com


Software Update and Recovery
Updating the BIOS
To determine whether available BIOS updates contain later BIOS 
versions than those currently installed on the computer, you need 
to know the version of the system BIOS currently installed.

BIOS version information (also known as ROM date and System 
BIOS) can be displayed by pressing fn+esc (if you are already in 
Microsoft® Windows®) or by opening the Setup Utility.

To use the Setup Utility for displaying BIOS information:

1. Open the Setup Utility by turning on or restarting the 
computer, and then pressing f10 while the “Press <F10> to 
enter Setup” message is displayed in the lower-left corner of 
the screen.

2. If the Setup Utility does not open with the system 
information displayed, use the arrow keys to select the 
Main menu.

When the Main menu is selected, BIOS and other system 
information is displayed.

3. To exit the Setup Utility, use the arrow keys to select Exit > 
Exit Discarding Changes, and then press enter.

Ä
CAUTION: To prevent damage to the computer or an unsuccessful 
installation, download and install a BIOS update only when the computer 
is connected to reliable external power using the AC adapter. Do not 
download or install a BIOS update while the computer is running on 
battery power, docked in an optional docking device, or connected to an 
optional power source. During the download and installation, follow these 
instructions:
■ Do not disconnect power from the computer by unplugging the power 

cord from the AC outlet.

■ Do not shut down the computer or initiate standby or hibernation.

■ Do not insert, remove, connect, or disconnect any device, cable, 
or cord.
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Software Update and Recovery
To download a BIOS update:

1. Access the page on the HP Web site that provides software 
for your computer:

Select Start > Help and Support, and then select the 
software and drivers update.

2. Follow the instructions on the screen to identify your 
computer and access the BIOS update you want to download.

3. At the download area:

a. Identify the BIOS update that is later than the BIOS 
version currently installed on your computer. Make a note 
of the date, name, or other identifier. You may need this 
information to locate the update later, after it has been 
downloaded to your hard drive.

b. Follow the instructions on the screen to download your 
selection to the hard drive.

Make a note of the path to the location on your hard drive 
where the BIOS update will be downloaded. You will need 
to access this path when you are ready to install the update.

✎ If you connect your computer to a network, consult the 
network administrator before installing any software updates, 
especially system BIOS updates.

BIOS installation procedures vary. Follow any instructions that 
are displayed on the screen after the download is complete. If no 
instructions are displayed, follow these steps:

1. Open Windows Explorer by selecting Start > All 
Programs > Accessories > Windows Explorer.

2. In the left pane of the Windows Explorer window:

a. Click My Computer and then your hard drive 
designation. The hard drive designation is typically 
Local Disk (C:).

b. Using the hard drive path you recorded earlier, open 
the folder on your hard drive that contains the update.
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Software Update and Recovery
3. Double-click the file that has an .exe extension (for example, 
filename.exe).

The BIOS installation begins.

4. Complete the installation by following the instructions on the 
screen.

✎ After a message on the screen reports a successful installation, 
you can delete the downloaded file from your hard drive.

Updating Software Programs and Drivers
To download and install software other than a BIOS update:

1. Access the page on the HP Web site that provides software 
for your computer:

Select Start > Help and Support, and then select the 
software and drivers update.

2. Follow the instructions on the screen to find the software you 
want to update.

3. At the download area, select the software you want to 
download and follow the instructions on the screen.

✎ Make a note of the path to the location on your hard drive 
where the software will be downloaded. You will need to 
access this path when you are ready to install the software.

4. When the download is complete, open Windows Explorer by 
selecting Start > All Programs > Accessories > Windows 
Explorer.

5. In the left pane of the Windows Explorer window:

a. Click My Computer and then your hard drive 
designation. The hard drive designation is typically 
Local Disk (C:).

b. Using the hard drive path you recorded earlier, open 
the folder on your hard drive that contains the update.
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Software Update and Recovery
6. Double-click the file that has an .exe extension (for example, 
filename.exe).

The installation begins.

7. Complete the installation by following the instructions on the 
screen.

✎ After a message on the screen reports a successful installation, 
you can delete the download package from your hard drive.

Recovering System Information
Tools provided by the operating system and PC Recovery 
software are designed to help you with the following tasks for 
safeguarding your information and restoring it in case of a system 
failure:

■ Back up your information regularly to protect your important 
system files.

■ Make a set of recovery discs (PC Recovery software feature). 
Recovery discs are used to start up (boot) your computer and 
restore the operating system and software programs to factory 
settings in case of system failure or instability.

■ Create system restore points (operating system feature). 
System restore points allow you to reverse undesirable 
changes to your computer by restoring the computer to an 
earlier state.

■ Recover a program or driver (PC Recovery software feature). 
This feature helps you reinstall a program or driver without 
performing a full system recovery.

■ Perform a full system recovery (PC Recovery software 
feature). With PC Recovery, you can recover your full 
factory image if you experience system failure or instability. 
PC Recovery works from a dedicated recovery partition on 
the hard drive or from recovery discs you create.
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Software Update and Recovery
Backing Up Your Information

When to Back Up
■ On a regularly scheduled basis.

✎ Set reminders to back up your information periodically.

■ Before the computer is repaired or restored.

■ Before you add or modify hardware or software.

Backup Suggestions
■ Create system restore points using Windows XP Professional 

System Restore feature.

■ Store personal files in the My Documents folder and back up 
these folders periodically.

■ Back up templates stored in their associated programs.

■ Save customized settings in a window, toolbar, or menu bar 
by taking a screen shot of your settings.

The screen shot can be a time saver if you have to reset your 
preferences.

To copy the screen and paste it into a Word document:

a. Display the screen.

b. Copy the screen:

To copy only the active window, press alt+fn+prt sc.

To copy the entire screen, press fn+prt sc.

c. To paste the copied images into a document, open Word, 
and then select Edit > Paste.
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Using System Restore Points
When you back up your system, you are creating a system restore 
point. A system restore point allows you to save and name a 
snapshot of your hard drive at a specific point in time. You can 
then recover back to that point if you want to reverse subsequent 
changes made to your system.

✎ Recovering to an earlier restore point does not affect data files 
saved or e-mails created since the last restore point.

You also can create additional restore points to provide increased 
protection for your system files and settings.

When to Create Restore Points
■ Before you add or extensively modify software or hardware.

■ Periodically, whenever the system is performing optimally.

✎ If you revert to a restore point and then change your mind, you 
can reverse the restoration.

Create a System Restore Point
1. Select Start > Help and Support, and then click System 

Restore.

The System Restore window opens.

2. Click Create a restore point, and then click Next.

3. Follow the on-screen instructions.
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Restore to a Previous Date and Time
To revert to a restore point (created at a previous date and time), 
when the computer was functioning optimally:

1. Select Start > Help and Support, and then click System 
Restore.

The System Restore window opens.

2. Click Restore my computer to an earlier time, and then 
click Next.

3. Follow the on-screen instructions.

Creating Recovery Discs
PC Recovery Disc Creator creates a set of recovery CDs or DVDs 
for the computer. Use recovery discs to restore the operating 
system and software programs to factory settings, in case of 
system failure or instability.

✎ Handle these discs carefully and keep them in a safe place. The 
software allows the creation of only one set of recovery discs.

Note the following guidelines before creating recovery discs:

■ You will need high quality CD-R, DVD-R, or DVD+R media 
(purchased separately).

✎ DVD±RW/R and double-layer DVD±RW are not compatible 
with the PC Recovery Disc Creator software.

■ The computer must be connected to AC power during this 
process.

■ Only one set of recovery discs can be created per computer.
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■ Number each disc before inserting it into the computer 
optical drive.

■ If necessary, you can exit the program before you have 
finished creating the recovery discs. The next time you open 
PC Recovery Disc Creator, you will be prompted to continue 
the disc creation process.

To create a set of recovery discs:

1. Select Start > All Programs > System Recovery > 
PC Recovery Disc Creator.

The PC Recovery Disc Creator tool opens.

2. Click Next.

✎ If you are operating the computer on battery power, you will be 
prompted to connect to AC power before you can go to the 
next step.

3. Select the type of disc you want to use and click Next.

✎ The software examines the image and displays the number of 
blank discs needed to create your recovery discs.

4. Insert the first disc and follow the on-screen instructions to 
complete the creation of the recovery discs.
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Reinstalling Software Programs and Drivers
If a program or driver preinstalled at the factory is accidentally 
erased or is damaged, the Application and Driver Recovery tool 
allows you to reinstall it.

✎ Software not provided with this computer must be reinstalled 
from the disc provided by the manufacturer or downloaded 
from the manufacturer's Web site.

✎ Before reinstalling the program, be sure it is fully uninstalled.

The Application and Driver Recovery tool replaces corrupted 
system files and reinstalls deleted system files within the 
program.

■ In most cases, if the program you are reinstalling is still on 
your computer, the reinstallation process does not affect your 
personal settings.

■ In all cases, if a program has been deleted from your 
computer, the reinstallation process reinstalls the program or 
utility to the factory image but cannot restore your personal 
settings.

Reinstalling Preinstalled Programs and 
Drivers

1. Remove the program or driver:

✎ In some cases, drivers are not listed in the Add or Remove 
Programs list. If the driver is not listed, it does not need to be 
removed.

a. Select Start > Control Panel > Add or Remove 
Programs.

b. Click the program or driver you want to remove, and then 
click Change/Remove.
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2. Select Start > All Programs > System Recovery > 
Application and Driver Recovery.

The Application and Driver Recovery tool opens.

3. Select Application Installation or Driver Installation, and 
then click Next.

4. Follow the on-screen instructions to complete the program or 
driver recovery.

5. Restart the computer if prompted.

Reinstalling Programs from Discs
1. Insert the disc into the optical drive.

2. When the installation wizard opens, follow the installation 
instructions on the screen.

3. Restart the computer if prompted.

Performing a Recovery
PC Recovery software allows you to repair or restore the system 
if you experience system failure or instability. PC Recovery 
works from recovery discs that you create or from a dedicated 
recovery partition on the hard drive.

✎ Microsoft Windows XP has its own built-in repair features, 
such as System Restore and driver roll-back capabilities. If you 
have not already tried these features, try them before using 
PC Recovery.

✎ PC Recovery only recovers software that was preinstalled at 
the factory. Software not provided with this computer must be 
reinstalled from the disc provided by the manufacturer or 
downloaded from the manufacturer's Web site.
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Recovering from the Recovery Discs
To restore the system from the recovery discs:

1. Back up all personal files.

2. Insert the first recovery disc into the optical drive and restart 
the computer.

3. Follow the on-screen instructions.

Recovering from the Partition on the 
Hard Drive
You can perform a recovery from the partition on the hard drive 
from either the Start button or f11.

To restore the system from the partition:

1. Access the PC Recovery tool:

❏ To access PC Recovery from the Start button, select 
Start > All Programs > System Recovery > 
PC Recovery.

❏ To access PC Recovery from f11, restart the computer and 
press f11 while the “Press <F11> for recovery” message is 
displayed on the screen.

The PC Recovery tool opens.

2. Select PC Recovery and click Next.

The computer restarts and the PC Recovery tool opens.

3. Click OK.

4. Follow the on-screen instructions to complete the system 
recovery.

If you want to perform a destructive recovery:

✎ A destructive recovery formats the hard drive and restores the 
computer to its factory state. Select this option only as a last 
resort.
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a. Click Advanced Options on the System Recovery screen.

b. Select Destructive Recovery and follow the on-screen 
instructions.

Deleting the Recovery Partition on the 
Hard Drive

The PC Recovery Advanced Options menu provides the option of 
deleting the recovery partition, which will increase space on the 
hard drive. Delete the recovery partition only if you have already 
created recovery discs.

Ä
CAUTION: After you create the recovery discs, you can increase 
space on the hard drive by deleting the recovery partition. However, 
doing this is not recommended. If you delete this partition, you will lose 
any information that is on the partition, including the PC Recovery 
software. Thereafter, you must use the recovery discs to access PC 
Recovery software.

To delete the recovery partition:

1. If you have not already created recovery discs, create 
them now.

2. Select Start > All Programs > System Recovery > 
PC Recovery.

The PC Recovery tool opens.

3. Select PC Recovery and click Next.

The computer restarts and the PC Recovery tools opens.

4. Click OK.

5. At the System Recovery screen, click Advanced Options.

6. Select Delete Recovery Partition (not recommended) and 
follow the on-screen instructions.
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Updating Reinstalled Software
After you perform a system recovery, connect to the Internet to 
update all reinstalled software.

To access update links for the operating system and other 
software provided on your computer:

» Select Start > Help and Support.

To update optional software, follow the instructions provided by 
the software manufacturer. Some programs include an update 
feature you can access from a Help button or menu within the 
program.
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Display Component Recycling

Å
WARNING: The backlight contains mercury. Caution should be 
exercised when removing and handling the backlight to avoid 
damaging this component and causing exposure to the mercury.

Ä
CAUTION: The procedures in this appendix can result in damage 
to display components. The only components intended for recycling 
purposes are the liquid crystal display (LCD) panel and the backlight. 
Careful handling should be exercised when removing these 
components.

✎ Materials Disposal
This HP product contains mercury in the display assembly 
backlight and may require special handling at end-of-life.

Disposal of mercury may be regulated because of environmental 
considerations. For disposal or recycling information, contact 
your local authorities or visit the Electronic Industries Alliance 
(EIA) at http://www.eiae.org.
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This appendix provides disassembly instructions for the display 
assembly. The display assembly must be disassembled to gain 
access to the backlight 1 and the LCD panel 2.

✎ Disassembly procedures differ from one display assembly to 
another. The procedures provided in this appendix are general 
disassembly instructions. Specific details, such as screw sizes, 
quantities, and locations, and component shapes and sizes, can 
vary from one computer model to another.

Refer to Section 5.14, “Display Assembly,” for display assembly 
disassembly steps.
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Perform the following steps to disassemble the display assembly:

1. Remove all screw covers 1 and screws 2 that secure the 
display bezel to the display assembly.

Removing the Display Bezel Screw Covers and Screws
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2. Lift up and out on the left and right inside edges 1 and the 
top and bottom inside edges 2 of the display bezel until the 
bezel disengages from the display assembly.

3. Remove the display bezel 3.

Removing the Display Bezel
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4. Disconnect all LCD panel cables 1 from the display inverter 
board and remove the inverter board 2.

Removing the Display Inverter Board
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5. Remove all screws 1 that secure the LCD panel to the 
display enclosure.

6. Remove the LCD panel 2 from the display enclosure.

Removing the LCD Panel
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7. Turn the LCD panel upside down.

8. Remove all screws that secure the LCD panel frame to the 
LCD panel.

Removing the LCD Panel Frame Screws
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9. Use a sharp-edged tool to cut the tape 1 that secures the side 
of the LCD panel to the LCD panel frame.

10. Remove the LCD panel frame 2 from the display panel.

Removing the LCD Panel Frame
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11. Remove the screws 1 that secure the backlight cover to the 
LCD panel.

12. Lift the top edge of the backlight cover 2 and swing it 
forward.

13. Remove the backlight cover.

Removing the Backlight Cover
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14. Turn the LCD panel right-side up.

15. Remove the backlight cables 1 from the clip 2 in the 
LCD panel.

Releasing the Backlight Cables
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16. Turn the LCD panel upside down.

17. Remove the backlight frame from the LCD panel.

Removing the Backlight Frame
Maintenance and Service Guide C–11



Display Component Recycling
Å
WARNING: The backlight contains mercury. Caution should be 
exercised when removing and handling the backlight to avoid 
damaging this component and causing exposure to the mercury.

18. Slide the backlight out of the backlight frame.

Removing the Backlight
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19. Disconnect the display cable 1 from the LCD panel.

20. Remove the screws 2 that secure the LCD panel to the LCD 
rear panel.

21. Release the LCD panel 3 from the LCD rear panel.

22. Release the tape 4 that secures the LCD panel to the LCD 
rear panel.

Releasing the LCD Panel
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23. Remove the LCD panel.

Removing the LCD Panel

24. Recycle the backlight and LCD panel.
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Connector Pin Assignments

Table D-1

Universal Serial Bus

Pin Signal Pin Signal

1 +5 VDC 3 Data +

2 Data – 4 Ground
Maintenance and Service Guide D–1



Connector Pin Assignments
Table D-2

RJ-45 (Network)

Pin Signal Pin Signal

1 Transmit + 5 Unused

2 Transmit – 6 Receive –

3 Receive + 7 Unused

4 Unused 8 Unused
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Connector Pin Assignments
Table D-3

S-Video-Out

Pin Signal Pin Signal

1 TV-Ground 5 TV-CD

2 TV-CVBS 6 TV-Ground

3 TV-Ground 7 TV-YD

4 TV-Ground
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Connector Pin Assignments
Table D-4

External Monitor

Pin Signal Pin Signal

1 Red analog 9 +5 VDC

2 Green analog 10 Ground

3 Blue analog 11 Monitor detect

4 Not connected 12 DDC 2B data

5 Ground 13 Horizontal sync

6 Ground analog 14 Vertical sync

7 Ground analog 15 DDC 2B clock

8 Ground analog
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Connector Pin Assignments
Table D-5

RJ-11 (Modem)

Pin Signal Pin Signal

1 Unused 4 Unused

2 Tip 5 Unused

3 Ring 6 Unused
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Connector Pin Assignments
Table D-6

Audio-In (Microphone)

Pin Signal Pin Signal

1 Audio signal in 3 Ground

2 Audio signal in

Table D-7

Audio-Out (Headphone)

Pin Signal Pin Signal

1 Audio out, left channel 3 Ground

2 Audio out, right channel
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Power Cord Set Requirements

3-Conductor Power Cord Set
The wide range input feature of the computer permits it to operate 
from any line voltage from 100 to 120 or 220 to 240 volts AC.

The power cord set included with the computer meets the 
requirements for use in the country where the equipment 
is purchased.

Power cord sets for use in other countries must meet the 
requirements of the country where the computer is used.
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General Requirements
The requirements listed below are applicable to all countries.

■ The length of the power cord set must be at least 1.5 m 
(5.0 ft) and a maximum of 2.0 m (6.5 ft).

■ All power cord sets must be approved by an acceptable 
accredited agency responsible for evaluation in the 
country where the power cord set will be used.

■ The power cord sets must have a minimum current capacity 
of 10 amps and a nominal voltage rating of 125 or 250 V AC, 
as required by each country’s power system.

■ The appliance coupler must meet the mechanical 
configuration of an EN 60 320/IEC 320 Standard Sheet C13 
connector for mating with the appliance inlet on the back of 
the computer.
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Country-Specific Requirements

3-Conductor Power Cord Set Requirements

Country/Region Accredited Agency Applicable Note Number

Australia EANSW 1

Austria OVE 1

Belgium CEBC 1

Canada CSA 2

Denmark DEMKO 1

Finland FIMKO 1

France UTE 1

Germany VDE 1

Italy IMQ 1

Japan METI 3

✎ NOTES:

1. The flexible cord must be <HAR> Type HO5VV-F, 3-conductor, 1.0 mm² 

conductor size. Power cord set fittings (appliance coupler and wall plug) 
must bear the certification mark of the agency responsible for evaluation 
in the country where it will be used.

2. The flexible cord must be Type SPT-3 or equivalent, No. 18 AWG, 
3-conductor. The wall plug must be a two-pole grounding type with a 
NEMA 5-15P (15 A, 125 V) or NEMA 6-15P (15 A, 250 V) configuration.

3. The appliance coupler, flexible cord, and wall plug must bear a “T” mark 
and registration number in accordance with the Japanese Dentori Law. The 
flexible cord must be Type VCT or VCTF, 3-conductor, 1.00 mm² conductor 
size. The wall plug must be a two-pole grounding type with a Japanese 
Industrial Standard C8303 (7 A, 125 V) configuration.
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Korea EK 4

The Netherlands KEMA 1

Norway NEMKO 1

People’s Republic 
of China

CCC 5

Sweden SEMKO 1

Switzerland SEV 1

Taiwan BSMI 4

United Kingdom BSI 1

United States UL 2

✎ NOTES:

1. The flexible cord must be <HAR> Type HO5VV-F, 3-conductor, 1.0 mm² 

conductor size. Power cord set fittings (appliance coupler and wall plug) 
must bear the certification mark of the agency responsible for evaluation 
in the country where it will be used.

2. The flexible cord must be Type SPT-3 or equivalent, No. 18 AWG, 
3-conductor. The wall plug must be a two-pole grounding type with a 
NEMA 5-15P (15 A, 125 V) or NEMA 6-15P (15 A, 250 V) configuration.

3. The appliance coupler, flexible cord, and wall plug must bear a “T” mark 
and registration number in accordance with the Japanese Dentori Law. The 
flexible cord must be Type VCT or VCTF, 3-conductor, 1.00 mm² conductor 
size. The wall plug must be a two-pole grounding type with a Japanese 
Industrial Standard C8303 (7 A, 125 V) configuration.

4. The flexible cord must be Type RVV, 3-conductor, 0.75 mm² conductor size. 
Power cord set fittings (appliance coupler and wall plug) must bear 
the certification mark of the agency responsible for evaluation in the country 
where it will be used.

5. The flexible cord must be Type VCTF, 3-conductor, 0.75 mm² conductor 
size. Power cord set fittings (appliance coupler and wall plug) must bear the 
certification mark of the agency responsible for evaluation in the country 
where it will be used.

3-Conductor Power Cord Set Requirements (Continued)

Country/Region Accredited Agency Applicable Note Number
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1394 port 1–11

A
all-in-one media cable, spare 

part number 3–18
analog TV tuner, spare part 

number 3–18, 3–24
arrow keys 1–13
audio troubleshooting 2–21
audio Y-cable 2, spare part 

number 3–18
audio-in jack

location 1–8
pin assignments D–6

audio-out jack
location 1–8
pin assignments D–6

B
base enclosure, spare part 

numbers 3–9, 3–22, 5–41
battery

removal 5–4
spare part numbers 3–9, 

3–23, 5–4
battery bay 1–9, 1–18
battery light 1–7
battery release latch 1–18

Bluetooth module
removal 5–49
spare part number 3–7, 

3–20, 5–49
Bluetooth module cable

illustrated 3–15
removal 5–50

bottom components 1–18
Bracket Kit

contents 3–7
spare part number 3–7, 

3–22

C
Cable Kit

components 3–15
spare part number 3–5, 

3–15, 3–21
cables, service considerations 

4–2
caps lock key 1–13
caps lock light 1–14
CMOS clearing 1–4
CMOS settings 1–4
components

bottom 1–18
front 1–6
keyboard 1–12
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Index
left-side 1–9, 1–10
right-side 1–8
top 1–14, 1–16

composite S-Video and audio 
cable, spare part number 
3–18, 3–24

computer feet
illustrated 3–14
locations 5–10

Computer Setup
Advanced Menu 2–5
Diagnostics Menu 2–4
File Menu 2–2
overview 2–1
Security Menu 2–3

computer specifications 6–1
computer, resetting 1–4
connector pin assignments

external monitor D–4
headphone D–6
microphone D–6
monitor D–4
RJ-11 D–5
RJ-45 D–2
S-Video-out D–3
Universal Serial Bus (USB) 

D–1
connectors, service 

considerations 4–2

D
design overview 1–20
Digital Media Slot 1–11
Digital Media Slot light 1–11
disassembly sequence chart 

5–2

diskette drive
OS loading problems 2–19
precautions 4–3

display assembly
removal 5–30
spare part numbers 3–3, 

3–23, 5–30
specifications 6–3

Display Hinge Kit, spare part 
number 3–13, 3–22, 5–33

display hinge support, removal 
5–53

display hinges, removal 5–39
display inverter board

removal 5–37
spare part number 3–13, 

3–22, 5–33, 5–37
Display Label Kit, spare part 

number 3–13, 3–24, 5–33
display panel

removal 5–37
spare part numbers 3–22

Display Panel Kit, spare part 
number 3–13, 5–33, 5–37

Display Plastics Kit
components 3–13
spare part number 3–13, 

3–22, 5–33
display release latch 1–7
Display Screw Kit, spare part 

number 3–13, 3–22, 5–33
drive light 1–7
drives, preventing damage 4–3
DVB-T TV tuner antenna, 

spare part number 3–18, 
3–25
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Index
DVB-T TV tuner, spare part 
number 3–18, 3–25

DVD/CD-RW Combo Drive
precautions 4–3
removal 5–17
spare part numbers 3–5, 

3–17, 3–23, 3–25, 5–17
specifications 6–6

DVD±RW and CD-RW 
Combo Drive

precautions 4–3
removal 5–17
spare part numbers 3–5, 

3–17, 3–21, 3–23, 3–26, 
5–17

specifications 6–8

E
electrostatic discharge 4–4, 

4–8
expansion port 2 1–11
expansion product

troubleshooting 2–14
ExpressCard assembly

removal 5–76
spare part number 3–5, 

3–22, 5–76
ExpressCard bracket, removal 

5–55
ExpressCard slot 1–8
ExpressCard slot bezel

illustrated 3–14
removal 5–52

external monitor port
location 1–10
pin assignments D–4

F
f1 to f12 keys 1–13
fan assembly

removal 5–68
spare part number 3–7, 

3–22, 5–68
features 1–2
feet

illustrated 3–14
locations 5–10

flowcharts, troubleshooting
no audio 2–21, 2–22
no network/modem 

connection 2–26
no OS loading 2–15
no OS loading from 

diskette drive 2–19
no OS loading from hard 

drive 2–16, 2–17, 2–18
no OS loading from optical 

drive 2–20
no power 2–8, 2–10, 2–11
no video 2–12, 2–13
nonfunctioning device 

2–23
nonfunctioning docking 

device 2–14
nonfunctioning keyboard 

2–24
nonfunctioning pointing 

device 2–25
fn key 1–13
front components 1–6
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Index
G
grounding equipment and 

methods 4–7

H
hard drive

OS loading problems 2–16
precautions 4–3
removal 5–6
spare part numbers 3–11, 

3–17, 3–25, 5–6
specifications 6–4

hard drive bay 1–19
hard drive cover

illustrated 3–14
removal 5–7
spare part number 3–7, 

3–14, 3–25
headphone jack

location 1–8
pin assignments D–6

headset, spare part number 
3–19, 3–20

heat sink
removal 5–61
spare part number 3–7, 

3–21, 5–61
HP remote control, spare part 

number 3–18

I
I/O address specifications 

6–12
interrupt specifications 6–10

K
keyboard

removal 5–28
spare part numbers 3–3, 

3–23, 3–24, 5–28
troubleshooting 2–24

keyboard components 1–12
keyboard frame

removal 5–22
spare part number 3–3, 

3–22, 5–22
keypad keys 1–13

L
Label Kit, spare part number 

3–18, 3–21
LED board

removal 5–26
spare part numbers 3–3, 

3–25, 5–26
left-side components 1–9, 

1–10

M
mass storage devices, spare 

part numbers 3–16
media cable, spare part number 

3–18
memory map specifications 

6–15
memory module

removal 5–11
spare part numbers 3–11, 

3–20, 3–21, 3–23, 5–11
memory shield, removal 5–12
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memory/Mini PCI module 
compartment cover

illustrated 3–14
location 1–19
removal 5–11

microphone jack
location 1–8
pin assignments D–6

Mini PCI communications 
module

removal 5–14
spare part numbers 3–11, 

3–20, 5–14
modem connector and cable

illustrated 3–15
removal 5–58

modem jack
location 1–8
pin assignments D–5

modem module
troubleshooting 2–26

monitor port
location 1–10
pin assignments D–4

N
network jack

location 1–10
pin assignments D–2

network, troubleshooting 2–26
nonfunctioning device, 

troubleshooting 2–14, 2–23
num lock key 1–13
num lock light 1–15

O
optical drive

location 1–8, 1–18
OS loading problems 2–20
precautions 4–3
removal 5–17
spare part numbers 3–5, 

3–17, 5–17
specifications 6–6

optical drive bracket, removal 
5–19

P
packing precautions 4–5
password clearing 1–4
password, resetting 1–4
PC Card assembly

removal 5–73
spare part number 3–5, 

3–23, 5–73
PC Card eject button 1–11
PC Card slot 1–11
PC Card slot bezel, illustrated 

3–14
plastic parts 4–2
Plastics Kit

components 3–14
spare part number 3–7, 

3–14, 3–21
pointing device, 

troubleshooting 2–25
power button 1–15
power connector 1–8
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power connector cable
illustrated 3–15
removal 5–57
spare part number 3–5, 

3–15
power connector cable, spare 

part number 3–25
power cord

set requirements E–2
spare part numbers 3–19, 

3–21
power light 1–7, 1–14
power management features 

1–5
power supply, spare part 

number 3–18, 3–21
power, troubleshooting 2–8
precautions

diskette drive 4–3
DVD/CD-RW Combo 

Drive 4–3
DVD±RW and CD-RW 

Combo Drive 4–3
hard drive 4–3
optical drive 4–3

processor
removal 5–64
spare part numbers 3–9, 

3–20, 3–23, 3–26, 5–64

Q
QuickLaunch buttons 1–15

R
remote control, spare part 

number 3–18, 3–21

removal
preliminaries 4–1
procedures 5–1

replacement
preliminaries 4–1
procedures 5–1

RF cable, spare part number 
3–18, 3–25

RF input adapter cable, spare 
part number 3–18, 3–24

right-side components 1–8
RJ-11 jack

location 1–8
pin assignments D–5

RJ-45 jack
location 1–10
pin assignments D–2

RTC battery
removal 5–16
spare part number 3–9, 

3–22, 5–16
Rubber Pad Kit, spare part 

numbers 3–21

S
Screw Kit

contents A–1
spare part numbers 3–13, 

3–19, 3–22, 5–33, A–1
screw listing A–1
SD Memory Card, spare part 

numbers 3–11, 3–20, 3–21
security cable slot 1–10
serial number 3–1, 5–1
service considerations 4–2
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Index
speakers
location 1–7
removal 5–71
spare part number 3–9, 

3–22, 5–71
specifications

computer 6–1
display assembly 6–3
DVD/CD-RW Combo 

Drive 6–6
DVD±RW and CD-RW 

Combo Drive 6–8
hard drive 6–4
I/O addresses 6–12
interrupts 6–10
memory map 6–15
optical drive 6–6
system DMA 6–16

static shielding materials 4–8
S-Video-out jack

location 1–10
pin assignments D–3

switch cover
removal 5–20
spare part numbers 3–3, 

3–23, 5–20
system board

removal 5–51
spare part numbers 3–7, 

3–25, 5–51
system DMA 6–16
system memory map 6–15

T
thermal paste

replacement 5–63
spare part number 3–7, 

3–22, 5–61, 5–64
tools required 4–1
top components 1–14, 1–16
top cover

removal 5–41
spare part number 3–3, 

3–22, 5–41
TouchPad bracket, spare part 

number 3–3, 3–22, 5–41
TouchPad cable

illustrated 3–15
removal 5–48

transporting precautions 4–5
troubleshooting

audio 2–21
Computer Setup 2–1
expansion product 2–14
flowcharts 2–6
keyboard 2–24
modem 2–26
network 2–26
nonfunctioning device 

2–14, 2–23
OS loading 2–15
overview 2–1
pointing device 2–25
power 2–8
video 2–12

TV tuner remote control, spare 
part number 3–18, 3–25
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U
Universal Serial Bus (USB) 

port
location 1–8, 1–11
pin assignments D–1

unknown password 1–4
USB digital drive, spare part 

number 3–17, 3–19, 3–20
USB infrared receiver, spare 

part number 3–18, 3–25
USB travel mouse, spare part 

number 3–19, 3–20
USB/audio board

removal 5–59
spare part numbers 3–7, 

3–25, 5–59
USB/audio board cable

illustrated 3–15
removal 5–60

V
vent, locations 1–9, 1–19
video troubleshooting 2–12
volume buttons 1–15

W
Windows applications key 

1–13
Windows logo key 1–13
wireless antenna

removal 5–40
spare part number 3–13, 

3–22, 5–33
wireless button 1–15
wireless light 1–9, 1–15
workstation precautions 4–6
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